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(requires: JOBS Editor)

13.1 Introduction to the JOBS Module

JOBS is an environment aiming at complex acquisition
and data analysis with easy to use and comprehensive
user interface.

Features highlights:

• Well-plate, dish and slide support
• Conditional acquisition
• Set of ready-to-use templates
• Wizard for Operators
• Visual Programming Style
• Integrated Analysis
• Asset Management via Database
• Data Mining
• Remote Access and Sharing
• NIS-Elements platform

Jobs are automated procedures for complex image
acquisition and data analysis. Typically it is a condition-
al acquisition on well plates, dishes or slides for long
times. It may include Confocal and wide-field camera
acquisition combined with photoactivation or bleach-
ing.

The strength of Jobs is their flexibility. They rely on
building blocks that can be freely assembled into arbit-
rary procedures in order to fulfill any particular needs.
As all this is done visually using Drag-drop it is called
Visual Programming. This approach combines advant-
ages of programming - flexibility - and limits the draw-
backs: having to learn how to write a programming
source code.

When such procedures - Jobs - are executed, images
and analysis data are produced. The images are stored
in ND2 files. Metadata and analysis results are stored
in the database together with links to the ND2 files.

The complete acquisition history is stored in the data-
base as well as the whole organization and structure
of Jobs and Projects.

13.2 Jobs Explorer

13.2.1 Introduction to Jobs Explorer

Jobs Explorer is the heart of the HC Template and JOBS
Editor modules. Run the View > Analysis Controls >
JOBS Explorer command to display it. All jobs,
job runs and all acquired data are viewed and man-
aged throughout this window.

Figure 12.290. JOBS Explorer with the JOBS Editor
module

Database Name of the currently connected job data-
base is displayed in this row. The pull-down menu
provides tools for managing job databases. See 13.2.3
Database context menu.

Project Jobs are organized into Projects - virtual con-
tainers which help you organize your jobs. Create your
own project or use the default one. You can have pro-
jects named e.g. “cell proliferation”, “translocation”
etc. or name it by its author e.g. “Catherine”, “John”,
or for example use dates as project names.

However, since you can display results of the whole
project in a single result view, it may be a good idea
to keep similar jobs together. For instance it may be
useful to have a 5hour and a 10 hour proliferation jobs
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together in one project, but it may produce some
complications to put 6-well-plate data together with a
96-well-plates.

Jobs Results open Results of the selected Job.

Run This area aggregates predefine job templates
which are executed by clicking on their button.

List of job runs Jobs Explorer shows the contents of
one project at a time as a list of jobs. Each job can be
unfolded to disclose all instances of when it was run.
Single jobs (highlighted in bold) represent the definition
which can be viewed and modified in the job editor,
wizard or run time. The run instances can be opened
to reveal a view on acquired images and data.

Jobs Explorer shows the contents of one project at a
time as a list of jobs. Each job can be unfolded to dis-
play all instances of when it was run - so called Job
Runs. Single jobs (in bold type) represent the definition
which can be viewed and modified in the job editor,
wizard or run time. The run instances can be opened
to reveal a view on acquired images and data.

13.2.2 Jobs Explorer Options

New Adds a new project. The Project window ap-
pears. Enter name of the new project and/or a custom
description.

Properties Enables changing the information of
the active project which were set in the Projectwindow.
Projects (if not active) can be deleted here by clicking
Delete .

Results (Project), Results (Jobs) Opens the
results window of the selected project, job or job run.

New (requires: JOBS Editor) Adds new job to the
active project. The Job Definitionwindow appears. See
13.5 Job Definition Window for details about creating
new jobs.

Edit (requires: JOBS Editor)Opens the job definition
window and displays the selected job to be edited.

Delete Selected Job Removes the selected job.

Add New Job from Template (requires: JOBS Edit-
or) NIS-Elements AR comes with a set of job templates.
This button opens the Job Templates window where
you can select one of the templates and load it to the
JOBS Explorer. The predefined template cannot be
overwritten however if changed, it can be saved to your
new Job or exported to a .BIN file.

Import from File (requires: JOBS Editor) This but-
ton enables to import a previously saved job definition
into your current project.

HCA Fixed , HCA Live , HCA FixedwithWPL Executes
a job optimized for high content analysis of fixed/live
samples. A simple wizard appears. See 13.6.3 Using
Job Definition Wizard.

Order by The jobs in the list are ordered by Date
by default. Within this button, you can add a second
field for job sorting.

Show/Hide Jobrun Details This button dis-
plays/hides job details such as the Jobrun Description
defined in the Job Run Properties window accessible
from the context menu over the job run.

Run Job This icon appears next to a selected job
and is used for its execution.

... This button opens theQuick Start Toolbar Configur-
ation enabling to adjust the JOBS Explorer panel. Sys-
tem templates can be inserted into the buttons area
by checking their check box. Also Templates, Existing
Jobs or Jobs from a file can be inserted and arranged
in the window by dragging&dropping. To remove a
button, drag it below into the white area.
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13.2.3 Database context menu

Next to the path where the database is set, there is a
pull down menu marked with containing following
options.

Create New Empty... Click this button to create a new
database. Specify where it will be stored and enter its
name.

Create New Based on Current... Enables to select
which items will be copied into the newly created
database.

Open Existing... Opens an existing database from a
.dat file.

Rename... Renames the current database file.

Quick Open This option is used for fast switching
between the databases checked in the Manage Quick
Databases window. To edit the list of quick open
databases, click Manage and add/remove/move
up/move down your databases, check which of them
will be shown and specify the maximal number of the
recently used databases.

Refresh This function enables refreshing the
database.

Cleanup Frequent database inserts, updates, and de-
letes can cause the database file to become fragmen-
ted. This function rebuilds the entire database to im-
prove the speed when working with the database.

Edit JavaScript... Opens the Run Script dialog window
enabling to edit and run the selected JavaScript code.
Manage... opens the Manage JavaScript files dialog
window aggregating the recently used JavaScript files.
Please see: 13.14 JavaScript.

Run JavaScript... Executes the selected JavaScript
code. Manage... opens the Manage JavaScript files
dialog window aggregating the recently used JavaScript
files. Please see: 13.14 JavaScript.

Backup... Specify the folder where you want to backup
your current database and select whether to include
its images.

Restore... Click ... and search for the .bin file to load
your backed up database. Specify whether you want
to restore images (Include Images check box) and click
Restore .

Upload... This window opens the Upload dialog. Please
see: 13.11.6 Database Upload/Download. Click ...
and specify where the Remote database .dat file is
present. Use the check boxes next to each job to in-
clude/exclude them into/from the uploading process.
The Uploading Rules table below shows the compared
data status of both the local and the remote data-
bases. Adjust the Action to perform combo boxes to
set the merging rules and then click Upload to start
the uploading process.

Download... This window opens the Download dialog.
Please see: 13.11.6 Database Upload/Download.Click
... and specify where the Remote database .dat file
is present. Use the check boxes next to each job to
include/exclude them into/from the downloading pro-
cess. The Downloading Rules table below shows the
compared data status of both the local and the remote
databases. Adjust the Action to perform combo boxes
to set the merging rules and then click Download to
start the downloading process.

Import Files... Opens the Import Files into Current
Project dialog window enabling to import selected .nd2,
.tif and .tiff files into the current job.

Advanced Import Files... Opens the Advanced Import
Files into Current Project dialog window used for ad-
vanced image importing into the current job. Dimen-
sion, its parsing and loop can be defined before the
import.

Import BioStation CT Files...Opens the Import Biosta-
tion CT files into Current Project dialog window en-
abling to import selected biostation .CT files into the
current job.
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Properties... Enables setting the database root
folder, sharing properties together with image storage
properties. For more information about database
properties, please see: 13.11.3 Database Properties.

13.2.4 Context menu on a job

Run Job/Wizard Runs the selected job definition in
normal/wizard mode.

Edit Job Opens the 13.5 Job Definition Window con-
taining the selected job.

View Job Results...Opens the Job Results window (see
13.8 Running a Job, Viewing Results and Graphs).

Run Analysis Runs analysis (13.9 Analysis) on the job
run results contained in the selected job.

Rename Job Definition Enables renaming your job
definition.

Duplicate Job Definition Duplicates the selected job.

Delete Job Definition Deletes the selected job defini-
tion.

Lock Job Definition Locks your job definition so that
it cannot be changed in the 13.5 Job Definition Win-
dow.

Copy Job into another Project... Copies the selected
job into the selected destination project

Export Job Definition... Saves the definition of the
selected job as a .bin file into the specified folder under
a specified filename.

Export to TIFF Files... (requires: Local Option) Can be
used to export job results to TIFF.

Show in JOBS Toolbar control Places the selected job
on the 13.3 Jobs Toolbar as a button.

13.2.5 Context menu on a job run

View Job Results...Opens the Job Results window (see
13.8 Running a Job, Viewing Results and Graphs).

View Job Results in a New Window... Opens the Job
Results in a new window.

Run Analysis... Runs analysis (13.9 Analysis) on the
selected job results.

Open Containing Folder Opens a folder on your hard
drive containing your result image data.

Copy/Move Selected Jobrun Enables to copy/move
selected job runs into a new or already existing job.

Delete Job Run Deletes the selected job run.

Stitch Points into Large Image Opens the Image >
ND Processing > Stitch Multipoint to Large Image
dialog window enabling to stitch captured images into
a large image. This function works on any Job or HCA
with any Point loop if image overlapping exists. Result-
ing new (and modified) Job runs are put under the
same job into a separate group called Stitched Large
Images. These stitched images are shown stitched in
the Preview area inside Job Results window.

Maximum Intensity Projection Performs maximum
intensity projection on the selected dimension (Time
or Z-stack) of the selected job run.

Import Job Definition This button enables to import a
previously saved job definition into your current project.

Save this Job Definition As... Saves your job as a new
Job Definition (see 13.5 Job Definition Window).

Revert to this Job Definition Assigns the job settings
of the selected run to its Job Definition. By default the
Job Definition uses the settings of the latest run.

Job Run Properties Enables assigning short text notes
to each of your job runs.
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13.3 Jobs Toolbar

Jobs Toolbar (View > Analysis Controls > JOBS Toolbar
) has some common features with 13.2 Jobs Ex-

plorer. It enables organizing, editing and running single
Jobs, Job Wizards or Test Runs.

A job can be added to the toolbar from within the View
> Analysis Controls > JOBS Explorer window: right
click on the job name and select Show on Toolbar or
just drag and drop a Job from Jobs Explorer.

Figure 12.291. Jobs Toolbar with HCA templates

13.4 Basic Job Rules

Introduction

Jobs are automated procedures for image acquisition
and analysis. When a job is executed, images and
analysis data are produced. The images are stored in
ND2 files while metadata and analysis results are
stored in a database including links to the correspond-
ing ND2 files. A complete acquisition history is stored
in the database as well.

Order of execution

A job is composed of tasks. The order of tasks in a job
is essential because they are executed from top to
bottom. There are two kinds of tasks: simple tasks and

tasks which have blocks of other tasks nested inside
them (e.g. loops and conditions). If there were only
simple tasks, the job would be a mere chain of opera-
tions, very easy to assemble. On the other hand, it
would be too difficult to create a simple time-lapse
with 100 repetitions - having to copy the Capture task
100 times in a row. In order to avoid such copying,
JOBS provide the concept of loops. Loops can embed
other tasks. If a loop is run, it repeatedly executes the
whole inner block of tasks until the defined number
of repetitions is achieved.

Another task which embeds other tasks is the Condi-
tion ( Condition IF, Condition (If-Else)). Condi-
tions are used for branching the job (deciding within
the job flow). The embedded tasks are executed only
if the specified condition is satisfied. For example: a
condition in a job which scans a well plate can go like
this: “capture a multi-point sequence on a well only if
there is a fluorescence signal detected, otherwise
proceed to the next well”.

Figure 12.292. A simple job capturing an image on
each well center of the well plate selection

Rules

• Tasks are executed in order (from top to bottom).
• If a task contains child tasks, these child tasks are

executed in order (conditions) or repeatedly (loops).
• Tasks inside a condition are executed only if this

condition is fulfilled.
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Task position

Position of each task in the job definition is substantial.
In the following example, Time Lapse and Loop
over Points tasks are swapped, bringing com-
pletely different results.

Herein, points on the sample are created manually.
Time Lapse loop is then started for 10 minutes, execut-
ing embedded tasks every 20 seconds. Therefore a
Loop over Points (containing Capture ) is
executed. Hence, an image is captured for each pre-
defined point one after another. This capturing takes
place every 20 seconds during the 10 minute Time
Lapse interval.

If the Time Lapsetask is placed inside the Loop over
Points task, the job works differently. Images are cap-
tured (for the duration defined in the Time Lapse task
- 2 min in our example) on the first point, then for 2
minutes on the second point, etc. When all 2 min time

lapses of all points we are looping over are captured,
the job is finished.

Task dependency

Some of the tasks require other tasks to be present
in the job - they depend on them. For instance, a well-
loop which goes over wells requires a selection of wells
on a well plate in order to loop over it (otherwise the
job wouldn't know which wells to loop through).
Moreover, the well selection task requires a well plate
definition in order to know the dimensions of the well
plate, how many wells are present and their exact po-
sition.

Note

If a task is not set-up properly (e.g.: missing de-
pendent task, wrong task order in the definition,
wrong task setting,...) a red exclamation mark

appears in the caption of the concerned task.
The job cannot be executed until all such errors
are resolved.

Definition-Execution type tasks

Some operations consist of two separate tasks - one
for definition (e.g. Capture Definition ) and one
for execution (e.g.: Capture ). This is often useful
in situations where a single definition is to be executed
in different places of the job. If you wish to use such
a task, always place the definition task before the ex-
ecution task.
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In this example, DAPI optical configuration is used in
the Capture Definition task and Define Z-Stack

parameters are defined. Points are generated on
a dish and a loop over these points is created. On every
point an image is captured (not saved) and used for
the Cell Count Analysis . Information about the
cell quantity at each point of the dish is used in a
condition. If Cell Count is bigger than 0, all the tasks
inside this Condition IF task are executed (Define
Z-Stack containing Capture ). Hence, image
on each plane of the Z-Stack is captured (and saved).
Notice that Capture uses the same definition in
both places. If the user decides to switch the Optical
Configuration used (e.g. from DAPI to FITC), he can
simply change it in the Capture Definition and all
Capture tasks linked with this definition will use
the new setting.

Rules

• The Definition task (usually containing the word
Define, Definition,...) has to be placed above its Ex-
ecution task.

Loops

We can consider a well plate as a set of many wells.
To sequentially pass through all the wells in Jobs we
use Loops. Each processes (tasks) which we want to
execute on the well level have to be placed inside this
loop.

Note

Loop Over Wells does not move between the
wells on a well plate by itself. It is therefore im-
possible to expect pictures of single wells by pla-
cing just Capture inside the Loop OverWells

. To do so, you have to place the Move to
Well Center task ( Move to Well Center )
inside the loop right before capture. This task tells
the loop to move to the appropriate well.

Figure 12.297. Loop over Wells and Loop over
Points

In this job, stage moves to the center of the first well
of the well selection, auto focus is performed and
random points are generated (first level loop). Then
the job encounters the embedded second level loop.
Still on the same well these random points are looped
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through and image is captured for each point. First
level loop was now completed for the first well. Stage
moves to the second well and the inside of the loops
is executed repeatedly until all the wells of the well
selection are run through.

Rules

• Tasks contained in a loop task are executed re-
peatedly and from top to bottom.

Adjusting the Task Settings

Tasks have different parameters which need to be set.
These parameters are usually set at job-design time
by double-clicking the caption of the task. However,
crucial tasks can be selected and displayed within a
wizard out of the main job body, so that the person
running the job is not distracted by the whole job
structure (see 13.6.3 Using Job Definition Wizard).
Similarly, the same tasks can be displayed at runtime
which enables the user to interact with the job or make
decisions. Complex jobs can be parametrized (13.6.7
Defining Parameters) to be more user friendly.

Effective job building

To avoid errors when building a job, all of the rules
mentioned above have to be followed. The best prac-
tice is to think about the results we want to acquire
and then go backwards. Which devices are necessary
for our procedure? Is the procedure done only once or
shall it repeat? Do I need to change sample holders
(slides, well plates) during the job? Are there any de-
cision-making points? What images exactly do we want
to capture? Which device operations need to be done
before an image is captured? Also think about the user
interaction. Will the job be fully automatic or do you
want to adjust the parameters during the job run? Try
to answer all of these questions to make the job as
simple and effective as possible. After that, you can
start creating the job (see 13.6 Creating a Job).

13.5 Job Definition Window

Once an empty job is created or an existing job is
opened, the job definition window appears.

This window is the main place for the Job program flow
and for changing task parameters. Apart from the main
toolbar there are two main areas available:

The leftmost task palette All tasks available are dis-
played here in the form of icons (or icon+description).
Expert mode button switches between the simple
(basic tasks) and advance view mode (all tasks). Tasks
are organized into logical groups. Some tasks depend
on the presence of some devices. They may not appear
in the palette until that device is added into the device
manager (Devices >Manage Devices). To insert a task
to the job, drag its icon into the main area which forms
the job definition. Width and thus the number of the
icons(tasks) in every row in the task list can be set to
any number of icons by sliding the right border of the
task list.

Themain program area containing the job definition
This pane holds the tasks that form the program. Each
task has an icon and text that describes what the task
will do when executed. Every task has different para-
meters which are revealed by double-clicking on its
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caption. Tasks can be marked as to be shown in the
Wizard or at runtime. All tasks which were dragged
here will be run one after another until the job is fin-
ished.

Before thinking about single tasks you have to decide
whether you want to modify a predefined template
(13.6.1 New Job from Template), use the assistance
of the definition wizard (13.6.3 Using Job Definition
Wizard) or create a new Job from scratch (13.6.2 New
Blank Job).

Operation

Most of the editing operations are done by moving the
Tasks around. By simple dragging and dropping the
tasks from the left to the right you create your complete
Job sequence in a matter of minutes.

• To insert a task into the job program, drag the icon
to the main program area which contains the job
definition.

• To move a single task or multiple tasks to different
place, hold the task in the main area and drag it to
another place in the program.

• To delete a task from the program area, simply drag
it out of the job main program area.

• To set parameters of each task, double-click its
caption.

Warning

Some tasks depend on other and their order of
execution needs to be correct. Please see 13.4
Basic Job Rules to avoid error warnings when
setting up your Job.

Figure 12.299. Job Definition window

Window Options

Rows, Icons, Hidden These buttons change
the appearance of the task panel. It is possible to
switch between theRows + description view mode and
Icons view mode. In the Icons view mode it is possible
to change the width of the task panel by dragging the
right border line of the scroll bar. The task panel can
also be fully hidden by clicking on the Hide button in
the middle of the 13.5 Job Definition Window.

Expert mode Expert mode in JOBS displays all avail-
able tasks. By default, this mode is off and the Job
Definition window shows only the basic tasks.

Save Changes Automatically saves any changes
in the Job Definition.

Save As Saves the Job Definitionwith desired name
into a Project that could be then selected from the
13.2 Jobs Explorer.

Print Job Definition to Clipboard Copies a screen
shot of the current Job including key parameters into
the clipboard.
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Import Imports existing Job .BIN files into the Job
Definition window.

Export Exports current Job to a single .BIN file.

Properties This button opens the Job Properties
dialog window where following features related to the
current job can be set.

In the Job description edit box a description of each
job can be made and saved together with the Job. This
description is displayed in the caption of the JobWizard
and Job Execution Progress window.

Progress window section enables to Show/Hide Pro-
gress Window during the Job run or to preview image
in the Progress window after the first capture or on the
job start.

When Job definition changes section defines what is
done when changes in the job definition are made.
These changes can be saved to the current Job defin-
ition, saved as a new definition or the user is asked to
specify the location where to save them. Treat adjust-
ments in Wizard as Job change should be checked if
it is requested to apply the changes made in wizard
directly to the job definition.

Wizard section specifies when the Run button is shown
in wizard - always or only if all tasks are visited (high-
lighted green).

Advanced features section groups advanced features
such as enabling the Test Run, Parameters or Program-
mable Actions in Wizard.

Edit Wizard This button opens the Job Wizard edit
dialog window. Please see: Edit Wizard.

Parameters Each job can be parametrized on the
task level. This button opens the Job Parameters dialog
window where you can define the name of your para-
meter, type, values it takes and whether it requires
another parameter from the list to be set to a certain
value. You can also mark each parameter to be shown
in wizard/runtime. For more information about using
parameters, please see: 13.6.7 Defining Parameters.

Note

This button is visible only if Parameters are en-
abled inside Job Properties.

Run Job Executes the current Job.

13.6 Creating a Job

13.6.1 New Job from Template

Easiest way to start using Jobs is to choose from pre-
existing Job templates created for most laboratory
tasks. By clicking the Add New Job from Tem-
plate button in 13.2 Jobs Explorer you can access the
Job Templates. A template is a predefined set of tasks
(see 13.15 Task reference) which you simply insert
into your current job definition. The template can be
used either “out of the box” or you can select a tem-
plate closest to your objective and edit some of its
tasks or add other tasks into it. Double-click on the
desired template or press the Import button. The Job
Wizard window appears. You can now set up the
parameters step by step (see: 13.6.3 Using Job
Definition Wizard). To see the job definition and edit
the imported template, click Close and then click
Edit inside 13.2 Jobs Explorer.
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Figure 12.300. Job Templates

13.6.2 New Blank Job

1) Go to View > Analysis Controls > JOBS Explorer
window.

2) Here you can select an existing project or create
a new one by clicking the Add New Project
button.

3) After choosing a project click on the Add
New Job button.

4) The Job Definition window opens. Here you can
combine all different tasks to create a new job
fulfilling your research needs together with all
available devices compatible with NIS-Elements

AR. Just drag and drop tasks from the left into the
main area of the Job Definition window.

5) The tasks inside a job definition can be reorgan-
ized by dragging them up or down. Tasks which
are not needed can be deleted by dragging the
task out of the job window.

6) To set the task parameters, double click the cap-
tion of the appropriate task.

Note

Name field (if available) can be used to alter
the default name of the task, however some
tasks do not allow numbers at the beginning
of the name. Therefore letters may have to
be entered first.

7) Don't forget to save your job before closing the
Job Definition window.

13.6.3 Using Job Definition Wizard

A Job is usually run multiple times to acquire data in
different conditions. It happens that few parameters
have to be changed before each run (e.g. length and
interval of a time-lapse, well-plate metadata, like drug
concentrations or labels, or even threshold intensity
level). For this reason it is possible to mark some tasks
for reviewing in a Wizard. In this case it is possible to
run a Wizard where only the tasks that were marked
are presented for definition. To put a task into wizard
right-click the task and choose Put in Wizard.
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Figure 12.302. Putting tasks into Wizard

Definition Wizard is also useful for specialist / operator
role division. The specialist creates complex Jobs with
decisions and analyses. He does not want the operator
to see all the complexity of the task but still needs to
let him change a few parameters. The wizard enables
this.

Edit Wizard

Figure 12.304. JobWizard dialog window in the edit
mode

The Edit Wizard button opens the Job Wizard
dialog window in the edit mode. Wizard steps (tasks
that were marked with the wizard icon can be
freely sorted using the up and down arrows, ex-
cept the Parameters step which has to stay always
first. Wizard steps can be bound together by clicking
on the Connect or Disconnect buttons. For
each task, only selected options can be enabled for
the operator, and others can be disabled. Thus the
user working with the wizard can use only the options
checked in the list under each task (Enabled Tasks
Parameters).

15
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Three programmable actions (events) can be used to
validate the user's settings during the wizard run and
to adjust them pragmatically or to display warnings.
Tasks at the top of the Job Wizard edit window can be
used to create a “mini job” which is then performed
before the wizard opens - Open Wizard, between
each step/grouped steps - Move to Step or after
the Run button is clicked - Run JOB.

Texts of all used tasks can be changed (by clicking on
the task name) and their description can be edited
after clicking on the Edit Task Description icon.

Figure 12.306. Edit Task Description window

Font Style Select one of the predefined styles which
will be applied to the whole paragraph or the selected
text.

Undo Moves back through the history of changes.

Redo Moves forward through the history of
changes.

Cut Cuts the selected text into clipboard.

Copy Copies the selected text into clipboard.

Paste Pastes the selected text from clipboard to
the cursor position.

Bold Applies the bold font style.

Italic Applies the italic font style.

Underline Applies the underlined font style.

Bulleted list Applies a bulleted list to the para-
graph. Ctrl + - turns this function on/off.

Ordered list Applies a numbered list to the para-
graph. Ctrl + = turns this function on/off.

Decrease indentation Decreases the paragraph
offset.

Increase indentation Increases the paragraph
offset.

Text foreground color Changes color of the selec-
ted text.

Text background color Changes background color
of the selected text.

Font Size Changes size of the selected text.

Insert image Inserts an image (jpg, gif, png, bmp)
from a file.

Remove character formatting Removes any
character formatting from the selected text.

13.6.4 Defining Samples

First step of any job procedure is to define your
samples. You can choose between well plates, slides
or stage areas (free shapes). If defining standardized
sample holders (well plates, slides), it is recommended
to select the specific product model you are using from
the database. This can be done by clicking Select from
DB... .
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• For custom well plate definition, please see Custom
Well Plate Options.

• Slide definition is closely described here: Define
Slide .

• Any other free shapes on a stage can be defined
using Define Stage Area . Please see Define
Stage Area .

Note

Any sample holder that was selected/defined has
to be properly aligned. Well plates are aligned
using Align Plate inside Jobs or globally us-
ing HCA/JOBS > Well Plate > Align Well Plate.
Slides are aligned using Align Slide in Jobs
or globally using HCA/JOBS > Slide Holder > Align
Slide. Alignment of well plates and slides is stored
in the database. User can see not only absolute
stage coordinates but also coordinates relative
to the plate/slide. Relative coordinates are helpful
when later revisiting locations on the same or
different systemandwhen doing analyses outside
NIS-Elements (e.g. doing statistics in MS Excel).

13.6.5 Defining Capture

Before capturing any images using the Capture
task you have to define the capture settings in the
Capture Definition task window, where you select
your optical configuration to be used to capture each
of the channels. Typically, laboratory computer image
analysis systems consist of a computer, a camera, and
a microscope equipped with certain accessories (ob-
jectives, filters, shutters, illumination, rotary changers,
etc). Most of the mentioned microscopic hardware is
often motorized and therefore can be controlled via
NIS-Elements. In addition, it is possible to integrate
single settings of all these devices into one compact
set called Optical Configuration. It is recommended to
create several optical configurations containing partic-
ular devices settings. Then a single click can com-
pletely change the current hardware configuration. For
more information about setting up the Optical Config-
uration please see: .

13.6.6 Defining Loops

Loops are special repetitive tasks which contain an
inner block. When you fill this block with tasks and run
the loop, it repeatedly executes the whole inner block
of tasks one after another. You can then define
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whenever you want to stop the repetition (after a cer-
tain amount of time, number of loops, after a condition
is true, etc.). You can also loop tasks inside another
loop to make building of repeated processes even
more effective.

13.6.7 Defining Parameters

Parameters represent “conditions” for single tasks.
Multiple experimental situations can be prepared and
organized into a single job so that the operator does
not have to switch between many jobs.

A single task can carry many parameters. If all values
of its parameters are met at the beginning of the job
run, the task is executed. If one parameter value is
different than the initial parameter selection, the task
will be skipped.

To start using parameters, click the Properties
button inside 13.5 Job Definition Window and check
the Enable Parameters check box. Now click OK to
confirm the selection and open the Job Parameters
window by clicking the Parameters button. Click
the Add New Parameter button to add the first
parameter. Give it a name, choose its type (On/Off,
choice from a list of options or a numeric value) and
define the values it takes clicking ... . If multiple para-
meters are used one can require another one to be
executed. This conditional parameter can be selected
from the Requires parameter combo box. Don't forget
to mark where each parameter will be shown and ad-
justed - in Wizard, Run Time or both. When
done with defining all your parameters, click OK .

Now you need to assign prepared parameters to single
tasks. This can be done in the 13.5 Job Definition
Window by right-clicking on the desired task and
choosing Requires parameter.... Parameter relations
dialog window opens up.

Here you can choose from all parameter values defined
previously and Insert them separately or use them with
Operators defining an expression (e.g. Capture==Z-
Stack AND Analysis==Cell Count; task will
run only if the user selects to Capture a Define
Z-Stack and to use the Cell Count Analysis
at the beginning of a job run). After confirming the ex-
pression, it is displayed in the caption of the appropri-
ate task.

Before executing the job it is important to define the
initial parameter values at the top of the 13.5 Job
Definition Window.

Figure 12.310. Job Definition window showing the
initial parameter values
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After executing the job, a parameter table will be
shown. There you have to set the values you wish to
use in the current experiment and click Next . All the
subsequent steps of your job depend on this selection.

Figure 12.311. Parameter table in Job Wizard

Figure 12.312. Parameter table in Job Execution
Progress window

13.7 Merging Different Acquisition Types

From version 5.0, different acquisition types use a
unified storage system which enables the user to nest
different acquisition tasks while the result is a single
ND2 data set. See the examples below. The following
tasks are concerned:

• ND Acquisition
• Fast Timelapse
• Sequential Stimulation
• Simultaneous Stimulation
• Illumination Sequence
• Triggered Experiment

13.7.1 Simple Acquisition Tasks Inside a
Parent Loop

Triggered Experiment inside Time Lapse .

Figure 12.313. Result: TZ file

Illumination Sequence inside Loop Over Wells
:
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Figure 12.314. Result: MT file

Sequential Stimulation inside Loop over Points
:

Figure 12.315. Result: MT file

Fast Timelapse inside Loop over Points :

Figure 12.316. Result: MT file

Fast Timelapse inside Time Lapse :

Figure 12.317. Result: T file
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13.7.2 Merging Matching Z-Stacks

NDAcquisition inside Loop over Points inside
Time Lapse .

• Result: single TMPZ file
• The same Z-stack is captured for each Lambda

channel

Figure 12.318. TMPZ Experiment Scheme

Note

Instead of the ND Acquisition task, you could
also use the Z-Stack Loop task containing
a (multichannel) Capture , however, the ar-
rangement used in the example eliminates un-
wanted delays which occur when the filter-
changer is slower than the Z drive (e.g. if a piezo
Z is engaged).

13.7.3 (Not) Merging Z-Stacks Different for
Each Point

NDAcquisition inside Loop over Points inside
Time Lapse .
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• Assign Z-Stack to Point/Well/ND Acquisition
and Predefined Points are used to define dif-
ferent Z-stacks for each XY point.

• Result: multiple TZ files, different Z-Stacks cannot
be merged in one ND2 file.

13.7.4 Multi-point inside Multi-Point Loop

ND Acquisition (XY) inside Loop over Points .

• All XY positions (points) are merged together.
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• Result: single MP file 13.8 Running a Job, Viewing Results and
Graphs

13.8.1 Job Execution Progress window

Once the job is run (after clicking the Run Job
button) a window is displayed showing the progress.
Similarly to ND2 acquisition blue rectangles represent-
ing dimensions or frames turn green when captured.
The window shows the analysis results immediately
during the job after the analysis is done. Some tasks
require user interaction during the job progress (e.g.
Add/Edit Points Manually ) and other tasks can
be forced to do it as well if you check Show in runtime
(13.6.7 Defining Parameters). Once the task definition
dialog shows up, the Job execution is paused until user
confirms settings modification by pressing Next button.

The following picture shows a well plate selection of
6x10 wells being scanned. Green color indicates which
wells have been already captured, yellow indicates the
well being scanned at the moment (C9).

Figure 12.324. Job Progress Visualisation
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Auto Contrast Automatically adjusts contrast value
in the Preview image.

Reset Contrast Resets the contrast value.

View Binary Displays the binary layer in the pre-
view.

View Color Displays the color layer in the preview.

ViewOverlayDisplays the color layer and the binary
layer in overlay.

Hide HistogramHides/Shows the histogram below
the preview.

Show Well Plate Displays the Well plate view.

Show Heat Map Displays the Heat map view. Aver-
age or Last values of the Feature selected from the
first combo box can be shown above the heat map.
(Choose a feature that is displayed during the job
progress and select the last or average value - it dis-
plays a number of the Runtime steps.)

ResultsOpens the Job Results dialog window (see:
13.8 Running a Job, Viewing Results and Graphs).

Pause Enables to pause the experiment - then the
button changes to Continue . For example: if your
job does not perform auto-focus before each frame
but you see that the preview image is getting blurry,
you may pause the acquisition, re-focus and then start
it again by clicking Continue .

Finish When clicked, only images captured so-far
will be saved, the experiment will be ended.

Abort Click this button to end the experiment
without saving any data.

Note

Right-clicking on the image preview enables to
move the stage to keep an object in viewmanually
using the Move this Point to Center com-

mand. Context menu over the well plate enables
to display a Schematic View of the well plate,
show a scale bar (Show Scale) or move the stage
to the selected well, to a cursor position or to the
stage center. Context menu over the well preview
enables to display a scale bar.

13.8.2 Result View

(requires: JOBS Viewer)

Once the job run is finished, results are saved automat-
ically and the Job resultswindow opens. To open some
other saved job results, select the particular job/job-
run in the 13.2 Jobs Explorer and click Results .
The Job result window shows captured images and all
associated captured data of a single job run.

Figure 12.325. Job Results window

This picture shows a result of a well-plate experiment
displaying preview of the captured images in each well.
If multiple images are captured in a single well, they
are automatically stitched into a single large image.

Basic dialog areas

Basic navigation is done using the ND navigation bars
in the bottom part of the dialog window. Right side
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shows a preview of the selected well/frame with heat-
map controls and acquired data browser.

The Job results window enables to view the results
from “various angles”. There are three basic views:

• Thumbnail view
• Wellplate view (if wellplate was used during acquis-

ition)
• Grid view

In Thumbnail and Plate view you can view Images,
Heat-map of selected data values (Quantities, Acquis-
ition metadata and Analysis results) and labels (in case
of wellplates). Grid view displays all results in a tabular
form.

ND2 Interconnection

Double-clicking an image in the result view opens the
underlying ND2 file with that particular image frame
displayed. If the job consists of multiple ND files, just
a single image window stays open. To display each
ND2 file in a separate window, use alt + double
click . Both options are available also on the context
menu.

Reusing a Job Definition

ND2 files created in Jobs are saved together with their
Job Definition. To display or reuse this definition, simply
right-click on the opened image and chooseReuse Job
Definition.

Top Toolbar options

Huge Thumbnails, Large Thumbnails, etc.
Thumbnail view displays all acquired images in the
order of acquisition. Channel displayed in the thumb-
nails can be selected in the tabs below the thumbnail
view.

Wellplate Real layout of the plate is displayed.

Grid Images along with metadata are displayed in
a grid (see below). Filtering and grouping is supported
(you can sort and group by any column). Statistics can
be turned on. See Figure 12.329, “Job Result: Grid
View”.

Show Images Displays all acquired results as im-
ages.

Show Labeling In the wellplate or thumbnail view,
this button displays color labels for each well if the la-
bels were defined (please see: 13.10 Labels and
Metadata for more information about labeling).

Show Heatmap Independently on the current view
(thumbnails, well plate, grid), you can select a heat-
map which represents one of the meta-data values
(e.g. analysis results, gas concentration, temperature,
etc.). In the heat-map view you see the selected colored
squares instead of images. The color is based on the
value and can be tuned. If multiple data are acquired
in one well/frame (e.g. when multi points were cap-
tured in each well of the well plate), it is possible to
aggregate these data (calculate min, max, mean, sum,
SD, etc.) in order to get a single value per well. If one
of the aggregating features is selected from the combo
box, entire multi point bar is selected and the results
show the aggregated values. If one multi point is selec-
ted in the multi point control bar, Aggregate combo
box is automatically switched to None, displaying only
non-aggregated results of the currently selected multi
point.

An example of a heatmap is displayed in the following
picture. Displayed as thumbnails, each image is over-
laid by a color and a value both of which carry inform-
ation about the meta-data selected in the bottom-right
corner of the window. By default the color range of the
selected feature uses minimal and maximal values
found in the entire job run. The color scale range and
colors can be modified by the user.
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Figure 12.326. Job Result: Thumbnail View
(Heatmap)

Note

Select the meta-data to be displayed in the heat-
map in the Quantities panel (bottom-right area of
the window).

Displaying two features in a heatmap

Heatmap mode enables to view two features at once.
Open the Quantities panel and select a feature to be
displayed from the first tab. Then check the second
tab and select a feature. Both features are now dis-
played in the heatmap. Use the Properties Compare
Mode button to switch to the circle diameter mode
or back to the divided mode.

Figure 12.327. Circle diameter mode

Figure 12.328. Divided mode

Show Histogram Data of each image are repres-
ented by a histogram.

Aggregate Aggregates data by the selected feature.

Time Trend Time trend represented by arrows for
each image can be displayed using this button.

Show Feature Values Displays a numeric value
of the selected feature over each well.

Use Filter Activate this button to filter the results.
The filter can be defined by clicking the Define Filter
button.

Define Filter A filter may be applied to images
displayed in the result view. Click the Define Filter
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button to display a table with the filter definition. Toggle
the Use Filter button to turn the filter ON and OFF.

Figure 12.329. Job Result: Grid View

Auto Scale Intensity Performs automatic setting
of LUTs on the image thumbnails. Click on the pull-
down menu to reveal LUTs options. Scaling can be
based on a selected image (Scale From Selection) or
all images (Scale From All Loaded). To adjust the LUTs
settings, select Modify LUTs....

Export View Exports the well plate overview.

Show Selected Well/Jump to Wellplate
Switches between single well view and well plate view.

View Graph Click the black arrow next to this
button to choose a graph view from the list. Then click
the button to open the selected graph view. For more
information about viewing results in different graph
modes, please see: 13.8.3 Graph View.

Run Analysis This button runs an analysis on im-
ages captured using a job definition. See 13.9 Analysis.

View Definition (requires: Local Option)

Click this button to display the job definition window.
See 13.5 Job Definition Window.

Grid Settings Shows a table with all acquired
metadata. Each feature can be displayed or hidden in
the Grid View using the check boxes.

Show Preview Display or hide a small image pre-
view window.

Show Labels Display or hide the labels toolbar.
Labels of the wells selected in the wellplate layout are
highlighted here. Any label can be temporarily turned
off by unchecking the check box next to its name.

Show Quantities Display or hide the Quantities
panel showing image metadata.

Refresh Contents Hit this button to refresh the
currently displayed results.

Quantities toolbar

Set range from current view This button assigns
the left color to the lowest value and the right color to
the highest value present in the current data results
view.

Setmanual rangeApplies the custom minimal/max-
imal scale range. Click the ... button and enter the
minimum and maximum values to be used instead of
the default ones.

Click to apply the manual scale range.

Set maximum range Any manual scale changes
are turned off and the default (widest) range is applied.

% Feature values are represented by their percentage.
100% is assigned to the maximal and 0% to the min-
imal value.
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13.8.3 Graph View

(requires: JOBS Viewer)

Clicking on the View Graph icon in the result view
opens the graph view.

Note

To display different graphs of your results, click
the graph button to expand a combo box contain-
ing more options.

Figure 12.331. Histogram graph view

Top toolbar options

Graph selection The first button is used for select-
ing the graph type.

of Frames/of Objects/of Tracks Select
whether your graph results are related to image
Frames, binary Objects or Tracks.

Graph sub-type Specifies the graph sub-type.
Following types are available: Histogram,
Scatterplot, Barchart, XY Line,
Timechart.

Options Opens the Graph Options dialog window.
Color and line features of the graph can be adjusted

in the Appearance tab. X Axis and Y Axis Left modify
the axes.

Save Opens the Save Graph Settings window en-
abling to save the current graph settings into the
database.

LoadOpens the Load Graph Settingswindow used
for loading graphs settings from the database.

Import Imports the graph settings from a .graph
file.

Export Exports the current graph settings into a
.graph file.

Export This button enables to export the resulting
graphs into raster files or Clipboard. Data can be ex-
ported into MS Excel or copied to Clipboard as well.
Clicking the black arrow next to this button reveals a
menu which specifies further export settings (
Settings) and which graph features will be exported.

Zoom in/out Zoom in/out inside the graph
area.

Tabs on the left represent steps of setting-up your
graph visualization. Each tab has a check box, which
determines whether the tab parameters are influencing
the resulting graph or not.

Definition tab

In this tab, the user defines main properties of each
graph type. Settings are not the same for each graph
type. Generally features shown on the X and Y axis are
selected and their range, bins trend lines and other
variables can be adjusted.

Filter tab

Filter tab enables filtering results based on selected
features. These can be selected from the combo box
in the Column column. After choosing the feature for
filtering, select the Comparison type. Click the combo
box in the Value column to reveal a histogram suitable
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for quick value estimation or enter the numeric value
directly into the edit box. If you add multiple filtering
features, you can move them up/down in the list using
these arrows. You can also delete each filter
clicking on this icon.

Figure 12.332. Filter tab

Note

Only filters with the check boxmarked as checked
are used for result filtering.

Data Series tab

Series enable to view different groups of data in the
same graph. Each data series can be displayed in a
different color. Select one feature from the combo box
(label, quantity, class or any measurement result) and
adjust its starting and ending color. Bin types, their
ranges and limits, legend and other parameters can
be adjusted.

Figure 12.333. Data Series graph

Primary/Secondary Tiling tabs

Both define another two groupings enabling the user
to see more instances of the same graph populated
with different group data. Primary Tiling defines the
groups to be displayed in graph tiles horizontally
whereas Secondary Tiling defines them to be displayed
vertically. Grouping is defined as in the Line Series tab
except the colors.

Figure 12.334. Primary Tiling tab

Classification (requires: Local Option)

This tab is used to create classes over the resulting
graphs. These classes are easily defined by selecting
the class color, entering its name and specifying its
range (by editing from and to columns or by moving
the rhomb symbol directly inside the graph).

Histogram and Scatterplot allow manual classification
(scatterplot allows also gating).
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Figure 12.336. Four group scatterplot classification
based on the VAP and STR features

13.9 Analysis

A simple analysis (or a complex one) can be performed
either:

• Inside a job using analysis tasks (13.15.14 Analysis).
E.g. to make a decision what to do next based on
the analysis results - see: 13.13.2 Using Conditions.

Figure 12.337. Analysis task (Cell Count) used
inside a job

• On data acquired by a job (see: Analysis performed
on job results).

• On any opened image (see: 2.1 Analysis Explorer).

There are several predefined analysis types which are
listed here: 10.3 HCA Analysis. No matter what type

you choose, the top part of the definition window is
the same for all of them:

Capture This button acquires a single image ac-
cording to the current Capture definition settings. Use
this button to preview results of your analysis setting.
By altering your parameters (such as preprocessing,
thresholding,...) a binary image is modified within the
captured image.

Wellplate Navigation Opens the Wellplate Navig-
ation window where you can overview your well plate
and navigate to a desired well stage on a selected well
plate.

Save Recipe This button saves your recipe to the
recipe database. The recipes can then be managed
via the HCA/JOBS > Presets > Manage Recipes com-
mand.

Load Recipe This button loads your recipe from
the recipe database.

Import This button opens a dialog for importing
recipe files from your hard drive.

Export This button opens a dialog for exporting
recipe files to your hard drive.

Load Opens the Load Job Recipe dialog window
used for loading job recipes.

Help Opens the HTML Help about the analysis be-
ing set.

Analysis Name Analysis name will denote the particular
analysis in the result view. Analyses with the same
name are considered to be the same and thus avail-
able for aggregation.
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13.10 Labels and Metadata

Any color/text labels and any metadata can be as-
signed to each well of your well plate. Label defini-
tion/assigning and metadata assigning can be made
inside the HCA template or directly in the Label Wells

task (see: Label Wells ).

Figure 12.339. Sample Labeling tab inside a HCA
template

Figure 12.340. Label Wells task used inside
a custom job

13.10.1 Labeling/Quantities window

This window is the initial place for defining and assign-
ing labels (see Defining and Setting Labels) and for
assigning predefined metadata (see Defining and
Setting Metadata) to cells shown in the well plate
overview.
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Labeling/Quantities window options

Copy Copies selected labels/quantities into clip-
board.

Paste Pastes the labels/quantities from clipboard
into your Labeling/Quantities well plate overview.

Export Exports all labels and quantities for each
well plate preset into your clipboard.

Import Imports all data from clipboard. Two formats
for importing labels and quantities are available.
Please see: 13.10.5 Importing predefined presets from
spreadsheet applications.

Undo Standard Undo functionality.

Redo Standard Redo functionality.

Set Labels...Opens the Labeling/Tags window (see
Defining and Setting Labels).

Custom Metadata... This button opens the Select
Custom Metadata dialog window, where you can
choose predefined metadata. For their definition,
please see: Defining and Setting Metadata.

To label wells, make a well selection, choose the
metadata from the top right list and click the but-
ton next to the selected/entered value or right-click
on the selected wells and choose Set Custom
Metadata.

Deletes the selected value from all selected wells.

... Opens the Edit Cell dialog window.

This window enables to adjust the value/range of each
metadata and link a label directly to it.

Not Linked/Linked by Position/Linked by Barcode
If you are using a Plate Loader or a Manual Plate
List with multiple plates distinguished by a posi-
tion or a barcode, a new preset linked to this plate can
be created. Choose the link type from the combo box
and click Add... to confirm/adjust the preset name.

Add... Creates a new preset (map of the currently
defined well plate labeling and metadata of your well
plate) and saves it with a custom name. Define as
many presets as you like and switch in between them
using the combo box. If you mark the Label Wells
task to be shown during runtime, you can choose
the preset for the current job run from the Presets
combo box.

Manage Opens the Preset Manager containing a list
with all of your presets and links to the particular
plates. Here each preset can be renamed, removed
and its link can be altered.
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13.10.2 Defining and Setting Labels

Open HCA/JOBS > Presets > Manage Labels or click
Define... in the Label Wells task or Sample La-
beling tab of the HCA template. Click Set Labels...
task to create new labels. Labeling Tagswindow opens
enabling to define your labels by clicking , entering
a name and choosing a color label or optional descrip-
tion. When done with defining all of your color labels,
click OK .

Figure 12.343. Labeling Tags window used for
defining labels

Click Define... in the Label Wells task or in the
Sample Labeling tab of the HCA template to open the
Labeling/Quantities window (closely described here:
Labeling/Quantities window). Click and drag over the
table with your wells to select those you want to label.
You can use the shift key to select a range of cells or
the control key to select remote parts of the well plate.
By right-clicking on any cell, you get more selecting
options - i.e:. select all, invert all, select row, invert row,
select column and invert column. When you are satis-
fied with your well selection, right-click on one of the
selected wells and choose the desired labeling tag to
be assigned to these wells.

Labels can also be added/removed by selecting well(s)
and clicking on the labeling color.

13.10.3 Defining and Setting Metadata

Open the Manage Custom Metadata window
(HCA/JOBS > Presets > Manage Custom Metadata to
create new metadata.

Data Items tab

New Creates new custom metadata set.

Save Saves the current custom metadata definition
using the name on the left.

Import Enables to import custom metadata defini-
tion from a .xml file or reuse them from an existing
image file.

Export Enables to export current or all metadata
definitions to a .xml file.

Remove Removes the current metadata.

Presets tab

This tab is used for setting up metadata sets (grouped
metadata of different types). In the left list, single sets
are created, arranged, renamed or deleted. On the
right side of the dialog window, values of individual
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items are set. Predefined presets can be used in the
Custom Metadata task.

Defining metadata

Create a new metadata set - click on New and
give it a name. Click Add New and name your
first metadata, choose its type, enter a text description,
edit its properties, choose the default value and select
whether it ismandatory or not. Add as many metadata
as you like and confirm their definition by clicking OK .

Setting metadata

Click Define... in the Label Wells task or in the
Sample Labeling tab of the HCA template to open the
Labeling/Quantities window (closely described here:
Labeling/Quantities window). Click Custom
Metadata... to open the Select Custom Metadata
window where you can choose the metadata set from
the first combo box and select (by a check mark) which
metadata will be used in the current job. Make your
selection and click OK . In the wellplate table make a
well selection of wells to which you want to assign the
chosen metadata. To assign metadata to selected
well(s), right-click on the selection and choose Set
CustomMetadata and confirm your metadata selection
or click on the right side of the metadata name
listed in the top right corner of the window.

Once you are done with adding labels/metadata, click
OK to get back to the Label Wells task or
Sample/Labeling tab of the HCA template. You can
save your label as a XML file by clicking the Save
to file button. You can also import your saved labels
by clicking the Load from File button. Clear your
labeling any time by clicking the Clear button.

13.10.4 Labels and Metadata in Result View

After the HCA/Job containing labels/metadata is ex-
ecuted and finished, the Job Results window opens.
Click Show Labeling to display labels over wells.

Labels of the wells selected in the wellplate area are
highlighted in the labels toolbar (invoked by clicking

Show Labels ). Any label can be temporarily turned
off by unchecking the check box next to its name.

To assign prepared labels and metadata to the wells
displayed in the result view, copy the metadata inside
your spreadsheet application and click Import
Metadata in the results view. Please see 13.10.5 Im-
porting predefined presets from spreadsheet applica-
tions for importing prerequisites.

Figure 12.346. Job Results View displaying well
labels

13.10.5 Importing predefined presets from
spreadsheet applications

Two types of formats are supported for importing cus-
tom presets into the Labeling/Quantities dialog win-
dow. Labels and quantities have to be defined similarly
to one of the examples below.

1. Plate View

Figure 12.347. Plate View identification and
definition
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First row defines the plate (its name, name mean-
ing, hotel). Next row contains the value type (Label,
Numeric Value, Short Text, Long Text, Selection,
Date), value name (empty for Label) andUnit (empty
for Label). The values are then typed in the following
rows as they appear in the well plate.

Figure 12.348. Example of a Plate View table
format

2. List View

This view is used to label and quantity features of
each well by a single row record. First four rows
(Variant A) or three rows (Variant B,C) specify the
hotel position (optional), identify the plate, position
of each well on a plate, value types (Label, Numeric
Value, Short Text, Long Text, Selection, Date) with
value names and units. If the Plate name meaning
value contains an empty string “ ”, then the name
of the plate is used for plate identification.WellIndex

and Plate Position identifiers are considered to start
at 1.

Variant A

Figure 12.349. Variant A: list view identification
and definition

Figure 12.350. Variant A: example of a list view
table format

Variant B

Figure 12.351. Variant B: list view identification
and definition

Figure 12.352. Variant B: example of a list view
table format

35

JOBS and HCA



Variant C

Figure 12.353. Variant C: list view identification
and definition

Figure 12.354. Variant C: example of a list view
table format

Note

Both row and column well localisation can be
described using numbers starting from one
(1,2,3, ...) or by letters (A, B, C, ...). For example
well “B3” can also be described as well “23”,
“2C” or “BC”.

Linking with Plate Loader

Imported labels/quantities can be linked based on
position of the well plate in a hotel (Linked by Position)
or using a barcode (Linked by Barcode). Plate # selec-
tion among multiple hotels has to be unique, otherwise
the linking is not performed. E.g. if plates #1 and #2
from hotel 1 and plates #3 and #4 from hotel 2 are
selected in the Plate Loader , labels marked with
hotel number 1 to 4 are linked correctly. Whereas if
e.g. plate #1 is selected in both hotels the link for plate
1 is not created and a new preset named #1 is created
instead.

13.10.6 Labeling during runtime (requires:
Local Option)

Single wells or single points can be easily labeled with
a color and a name during runtime. Use tasks Create
Labels (see: Create Labels ) and Assign La-
bel (see: Assign Label ).

13.11 Job Database

(requires: JOBS Editor) or (requires: JOBS Viewer)

13.11.1 Database Backup

Warning

Always use the HCA/JOBS > Database > Backup
command when doing a backup. Copying the
“jobsdb.dat” file manually could corrupt the
database structure and the backup will be inac-
cessible.

Run the HCA/JOBS > Database > Backup command,
a dialog box appears. The backup routine copies the
database file to a specified folder. If image files are
also backed up (recommended) they are copied as
well. The backup folder is a regular database bundle
and can be accessed fromNIS-Elements. If the backup
folder already contains a previous backup, it is merged
in the following way:

• The previous database file is renamed (current date
is appended) and a new file is created.

• New image files are added to the backup folder.
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Please see 13.11.3 Database Properties chapter on
how to set the database.

13.11.2 Database Restore

This operation replaces the content of the current
database folder with the content of the backup folder.
Restoring the database destroys the original content
of the current database.

Press the ... button to browse to your database folder.
After selecting it, click OK and Restore to finish the
restoration process. You can uncheck the Include Im-
ages check box in case you don't want to restore image
files.

13.11.3 Database Properties

Projects, jobs and job results are stored in a database.
This database contains all metadata except images
acquired by jobs. Images are not stored in the data-
base file. This is for two reasons: efficiency and data
security. As images are ordinary nd2 files they are in-
dependent of the database and can be opened byNIS-
Elements directly. Images are marked as read-only
and should not be modified in NIS-Elements. On the
other hand, the database can be opened and accessed
without the images. Therefore images are stored in
folders and the database contains relative paths to
them. Images and database files exist in a folder and
make a bundle. This bundle can be copied as a whole.
However it is not safe to copy the folder while it is ac-
cessed by NIS-Elements. Use the 13.11.1 Database
Backup / 13.11.2 Database Restore functions instead.

You can adjust the following database settings after
you click the Database Properties button:

Database root folderDefine the path to your database
files and select the type of access to the data. You can
choose between:
• Local database - recommended, fast, safe.
• Shared database (synchronous) - opt this if access

from multiple PC's is required. This setup is safe and
sufficient for long-lasting experiments (e.g. 1 frame
per minute).

• Shared database (asynchronous) - if access from
multiple PC's is required along with the speed of
access. Regular back-ups are absolutely necessary
with this setup.

Warning

If an unexpected error such as power failure
occurs while the database is being accessed,
the database may get corrupted (lost).

Image files are stored in Choose in which form you
want to save your image files. The following options
are available:
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• <JobName>\YYYYMMDD_HHMMSS_mmm\<files:
A1.nd2, A2.nd2 ...>

• YYYYMMDD_HHMMSS_mmm__<JobName>\<files:
A1.nd2, A2.nd2 ...>

Y = Year, M = month, D = day, H =hour, M = minute,
S = second, m = millisecond

13.11.4 Database Files

The jobs database is contained in the jobsdb.dat
file in the database folder. It contains the project and
the job hierarchy, all the definitions (jobs, analysis re-
cipes, labels, tags, etc...), acquisition data like plate
or well information, loop indexes, time analysis results,
links to the image files and much more. All this inform-
ation is stored in a single file. The database file is
usually much smaller than the size of an image file.

Other temporary files may also appear in this folder
(typically jobsdb.dat-shm, jobsdb.dat-wal or
jobsdb.dat-journal). These files indicate that
the database is in use. All temporary files should dis-
appear after all NIS-Elements applications accessing
that particular database are closed. If NIS-Elements
did not finish properly, these files may remain. They
must not be deleted as they contain a valid database

state. In this case NIS-Elements should be launched,
database connected and NIS-Elements closed again.
Note that it is not safe to copy the .db file at that
moment. NIS-Elements is connected to a single Jobs
database at any given time - it is the current database.
The current database can be changed in Database
Properties (see: 13.11.3 Database Properties). NIS-
Elements stores the current database folder on per
user basis which means that every user can have his
own database.

Database size

To avoid deposit and upgrade difficulties caused by
huge databases, please follow the basic database
rules.

• Make smaller, more manageable databases (use
HCA/JOBS > Database > Create New Empty).

• Measure features per object only where it makes
sense - e.g. in many HCS analyses on a well-plate,
statistics per frame (not per object) may be enough.

• Cut off irrelevant data before merging databases.

If the database is still huge, it makes sense to put the
.db file on an SSD disk (must be big enough) and
mount a normal drive to “Projects”. Navigate to the
folder containing your database file and execute the
following command (from the command line):mklink
/J Projects "C:\Temp", where “C:\Temp” is the
folder of your choice.

Note

If you experience any other problems with the
database (slow performance, crashing, ...), try to
clean up the local and remote database
(HCA/JOBS > Database > Cleanup).

13.11.5 NIS-Elements Upgrades

With new versions of NIS-Elements the database file
format may change to support new features. An up-
grade of the database is required before it can be used
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by a new version of NIS-Elements. However, the up-
grade renders the database inaccessible from any
previous version of NIS-Elements. It is a good practice
to make a backup of the database before an upgrade
of NIS-Elements is made, although
<name>_backup_<date>_<time>.dat backup
file is created automatically before the upgrade is
performed. When the database is accessed by multiple
NIS-Elements instances, they all must be working with
the same database version.

13.11.6 Database Upload/Download

(requires: JOBS Remote Database)

Downloading a remote database or uploading a local
database can result in database merging. Parameters
and rules of database merging are specified in the
Upload/Download dialog window.

Dialog window options

Local Database If necessary, click ... and specify
where the Local database .dat file is present.

Remote Database Click ... and specify where the
Remote database .dat file is present.

Project Use the check boxes next to each job to in-
clude/exclude them into/from the uploading/down-
loading process.

ContentDisplays the number of job runs and acquired
images per each job definition. If the content displays
this symbol, some files are missing in the source
database.

Uploading Rules This table shows the compared data
status of both the local and the remote databases.
Adjust the Action to perform combo boxes to set the
merging rules and then click Upload / Download to
start the uploading/downloading process.

Note

New data of runs/analyses/tags are transferred
only if Overwrite is selected. New projects and job
definitions are transferred always (selected only).

Invalid actions

• downloading/uploading into the same database
• downloading/uploading into a database created

using a different version of NIS-Elements
• downloading/uploading into a local database on a

network drive
• downloading/uploading into a network database

folder on a network drive with read-only permission
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13.12 Advanced Settings

13.12.1 SMTP Configuration for Sending
Email/SMS Messages

You can make a running job send you messages via
email or SMS (see Send E-mail Notification and
Send SMS Notification tasks). To do this success-
fully, SMTP server and email account settings must be
defined correctly. Run theHCA/JOBS > Presets > Email
Setup command to display the following window and
fill all its fields.

Server Enter the name of your server (e.g.
“smtp.mydomainname.com” or “mail.mydomain-
name.com”).

Port Enter the server's port number.

Server requires authentication Check if your server
requires authentication.

Login If the SMTP server requires authentication, fill
in the appropriate user account name (e.g. “first-
name.surname”).

Password If the SMTP server requires authentication,
fill in the password for the “SMTPLogin” account.

Sender e-mail Type the email address which will be
displayed in the “from” field (and also used as the
“reply-to” address).

Your name “Alias” of the sender email - usually a hu-
man-readable equivalent of the email address. E.g.
“Peter Smith” for an address such as ps001@com-
pany.com

Test Account Settings Click this button in order to test
your SMTP configuration.

13.13 Use Cases

13.13.1 Analysis Use Cases

• 2.5.4 General Analysis in NIS-Elements - Model Use
Case

• 2.5.5 General Analysis in JOBS Module - Appended
Point Set Use Case

• 2.5.6 General Analysis in JOBS Module - Replaced
Point Set Use Case

13.13.2 Using Conditions

Condition ( Condition IF ) is a great tool useful in
all sorts of laboratory situations where we define which
parameters influence the task execution. Condition
tasks need to be defined using expressions (see
13.13.3 Using Expressions). For example: If Expression
is TRUE, run the contained tasks...

Figure 12.362. Example of an expression

Deciding whether the condition is TRUE or FALSE is
called “evaluation” and it is computed byNIS-Elements
on job runtime.

Almost every task produces number of variables which
are then available within the Expression task.
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Condition use case

Let us show you the usage of an condition on a simple
job. We will capture a large image in low resolution
and measure its mean intensity. Only if the mean in-
tensity is above the defined threshold (which may in-
dicate that there is something interesting on the
scene), we will capture the large image again this time
using a high magnification objective.

1) Create two capture definitions

Define two Capture Definition tasks, each
using a different optical configuration. Assign
some simple names to the tasks.

2) Capture the preview image

Insert the first Capture task and set it so
that it will use the low magnification capture
definition - choose the Preview Capture definition
from the Using combo box. Since purpose of this
task is to decide whether to capture the high-
magnification image or not, there is no need to

save the images, so leave the Save Image to
Database pull-down menu set to Never or Later.

3) Analysis Definition

Insert the Intensity Analysis task and double-
click on it to specify its parameters.

Because intensity of the whole frame will be
measured, just select the Full frame option and
click OK .

4) Conditional Capture

By now, everything is prepared to make the de-
cision whether to capture the high-resolution im-
age or not. We captured a preview image, meas-
ured its intensity and now we can set the resulting
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value into the Condition IF task and add
another Capture task within.

Specify the conditional expression (Condition). If
evaluation (result) of this expression is TRUE (i.e.
1), the capture will be performed. Use the Define
button to specify the conditional expression as
described in (13.13.3 Using Expressions). The
resulting job could look like this:

13.13.3 Using Expressions

An expression in Jobs is a combination of explicit val-
ues, variables, operators and functions (see: Wikipedia
[http://en.wikipedia.org/wiki/Expression_(programming)]).
It is typically in the form of an assignment (variable =
expression) whereby a value is computed (by evaluat-
ing the expression on the right side) and assigned to
a variable (on the left side). Expression is evaluated
and assigned to the variable when the task is executed.

Expression use case

In the following text we show an example which uses
an expression. Imagine that we want to capture ran-
dom positions on a dish. We want to finish capturing
when we gather 3000 objects.

First of all we have to define our capture using the
Capture Definition . We choose the optical config-
uration and insert the Variables task which we
set as follows:

Then we insert the Generate Points task, define
the dish area on the stage and adjust point generating
parameters as shown in the following picture.
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Finally we insert the point loop ( Loop over Points )
and fill it with Capture , Cell Count Analysis ,
Expression and Condition IF .

Double-clicking on the analysis task we can further
define its parameters (see 2.2 Cell Count Analysis).

In the task expression we enter the following expres-
sion: TotalCells = TotalCells +
Job.CellCount.Count

Into the Condition IF task we define the following
condition: TotalCells > 3000. Inside the condition we
insert a Break ( Break ). Thus if the condition is
true (we receive 3000 objects), the whole job stops.

Figure 12.370. Loop and its containing tasks

The final job looks as follows:

Figure 12.372. Job Execution Progress window
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Figure 12.373. Final results

For more information about Jobs Progress and Results
window, please see 13.8.1 Job Execution Progress
window and 13.8 Running a Job, Viewing Results and
Graphs.

13.13.4 Using Questions

Question ( Question ) is a useful task if you want
to stop your job in a specified part of the Job sequence
and let the user decide what to do next. Start by drag-
ging the Question task into the main area of the
Job Definition window (see: 13.5 Job Definition Win-
dow). Then double click the task to maximize it and
set up your question.

Figure 12.374. Question task.

Name your Question task, choose an icon which will
be displayed together with your question and type a
text into the Caption box to be used in the dialog win-
dow heading. Then type in the text of your question.

Wait for user action If checked, the question dialog
shows at the bottom of the Job Execution window
(13.8.1 Job Execution Progress window)and pauses
the job until the question is answered by user. After
that, the job continues or terminates depending on
the question settings. If solely this option is checked,
the question dialog disappears until the loop meets
the question again (e.g. until the next Capture).

Keep visible during current loop execution Displays
the question dialog during the whole Job run. The an-
swering buttons are disabled (gray) until the loop meets
the question again.

Continue execution and stay visible Proceeds the job
even without user interaction (answering the question).
The question dialog stays visible until the job run is
over.

If any variables are available, check Input values. Click
the Add New button, modify the Text or change your
variables by clicking the ... button. During the Job exe-
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cution the question task asks you to input these vari-
ables manually. Finally define your question buttons.
You can use basic predefined buttons by clicking the
Predefine Combination button or add your custom
buttons and captions.

Tip

Assign the Escape and Enter key to two of your
buttons for faster work with questions during the
Job progress.

13.13.5 Using Time Lapse

In the following example we will build a job benefiting
from the Time Lapse , Time Lapse and
Condition IF tasks. This job will guard the temper-
ature of our device and will alter the image capture in
compliance with its current temperature. This type of
job is advisable especially when working with living
objects (e.g. cells).

Figure 12.375. Overview of the job.

We start by defining our capture (selecting Optical
Configuration) and inserting the first Temperature and

Gas Control task where we set the target temper-
ature of our device to 37°C. We go on with inserting
a Question task. We want the user to have an
option to stop the job progress at any time, so we
define a Stop Acquisition button and check Continue
execution and stay visible. Task setting details are
shown in the following picture:

During normal conditions we want to capture every 30
minutes and we want the Time Lapse to enable
quitting at any time. Therefore we check the Finish
when condition is TRUE and Define the Stop Acquisition
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button from our question. We continue by inserting
our Capture task followed by an Condition IF

task containing another Temperature and Gas
Control , Send E-mail Notification and a
Break . If the temperature of our device exceeds
40°C, the Time Lapse stops and an e-mail is sent
to the user with custom warnings about the job termin-
ation.

Our live sample behaves differently under cold and
warm temperatures, therefore we right-click on the
frame of our Condition IF task and choose Add
“If Else”. If the temperature of our device is greater
and equal than 34°C we want to capture every 30
seconds. Because our specimen moves slower under
colder temperatures we define another condition
(“Devices.Temp<34”) as in the first case by right-

clicking the If task and selecting Add “If Else”. Accord-
ingly if the temperature is lower than 34°C we want
to augment the capture interval to 3 minutes (see the
following settings).

13.13.6 Creating PFS Surface

Perfect Focus System Surface, displayed in the XYZ
Overview (see: View > Acquisition Controls > XYZ
Overview ) can be defined using a job. Following
example shows PFS Surface definition on a well plate.
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Auto PFS Offset Settings task defines settings(Op-
tical configuration) to be used by the Find Auto PFS
Offset task. On each well ( Loop Over Wells )
of the well selection ( Select Wells ), the stage
moves to the center of a well ( Move to Well Center

), turns on PFS ( PFSOn and Focus ), automat-
ically finds the PFS offset value ( Find Auto PFS Offset

), assigns it to the each well ( Assign PFS to
Point/Well ) and turns PFS off ( PFSOff ). Once
all wells undergo this procedure, the PFS Surface is
finally created on the well selection using the Create
PFS Surface task.

13.14 JavaScript

Standard (ECMA-262) JavaScript syntax is supported
in NIS-Elements.

13.14.1 Constructors

There are three table constructors for each data type:

• new FrameTable(columnList, whereClause, order-
Clause)

• new ObjectTable(columnList, whereClause, order-
Clause)

• new TraceTable(columnList, whereClause, order-
Clause)

where:

columnList: [“columnName1”, “column-
Name2”, …, “columnNameN”]

The parameter specifies column names of the columns
which will be accessible in created table (as columns).
Columns are ordered as they appear in the list. To learn
how to name the columns see section “The format of
column names”.

whereClause: “columnName1 = value
AND/OR

AND/OR columnName2 = value AND/OR …”

The parameter defines which jobruns will be included
in the table (as rows). Currently, following patterns are
recognized (and can be combined using AND or OR
operators):

• only specified jobrun will be included

“Jobrun.ID = value”

“Jobrun.name = ‘value’”

• all jobruns contained in specified job will be included

“Jobdef.ID = value”

“Jobdef.name = ‘value’”

• all jobruns contained in specified project will be in-
cluded

“Project.ID = value”

“Project.name = ‘value’”

orderClause: “columnName1 ASC/DESC,
columnName2 ASC/DESC, …”

This parameter is optional. If specified it defines the
row order.
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13.14.2 Member Methods

Following methods (function properties) are defined
on a table object:

• length()

Returns the number of rows in the table.
• column(columnName)

Returns the index of given column (same as in con-
structor).

• addColumn(columnName)

Creates (or modifies) a column and returns its index.
Column is added to “Others” group.

• commit(columnList)

Writes modified data into database. Only columns
mentioned in addColumn() method are stored.
The parameter columnList is optional if omitted
all columns added using addColumn() are saved.
Any modification to any other data is temporary.

13.14.3 Indexing

Data are accessed using indexing operators:

• table[rowIndex][colIndex]

13.14.4 Format of Column Name

The column name is formed as seen in JobsViewer
column tree (red frame in the picture).

Items appearing inside another one (parent) is named
as follows: parent.child. The matching is case-insens-
itive.

Sometimes (in the case of analyses) the item has a
grandparent group: analysis.channel.feature.

For convenience where the Parent and an item starts
with the same word it can be omitted:

Jobdef -> Jobdef Name can be addressed by both
“Jobdef.name” or “jobdef.jobdef name”.

In some cases the aggregation part (Mean, Min, Max,
…) of column name is needed, for example:
“CellCountAnalysis.DAPI.EqDia.Mean”.

Expressions “ID” and “Key” are equivalent (except
while using with “Object” or “Trace”):

“Jobrun.Key” = “Jobrun.ID”, “Job-
def.Key” = “Jobdef.ID”, but “Ob-
ject.Key” ≠ “Object.ID”.

13.14.5 Code Example

var table = new FrameTable(["Image.Cal-
ibration", "Image.Width", "Im-
age.Height", "Mono.Count"], "jobrun.id
= 116");

var columnCalibration =
table.column("Image.Calibration");

var columnWidth = table.column("Im-
age.Width");

var columnHeight = table.column("Im-
age.Height");

var columnCount =
table.column("Mono.Count");

var columnConcentration = table.ad-
dColumn("Concentration");

for (row in table)

{
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var volume = table[row][columnWidth]
* table[row][columnHeight];

volume *= Math.pow(table[row][columnCal-
ibration], 2.0);

volume *= 10 * 1000;

table[row][columnConcentration] =
table[row][columnCount] / volume;

}

table.commit(columnConcentration);

The same example using column indices:

var table = new FrameTable(["Image.Cal-
ibration", "Image.Width", "Im-
age.Height", "Mono.Count"], "jobrun.id
= 116");

var columnConcentration = table.ad-
dColumn("Concentration");

for (row in table)

{

var volume = table[row][1] *
table[row][2];

volume *= Math.pow(table[row][0], 2.0);

volume *= 10 * 1000; table[row][colum-
nConcentration] = table[row][3] /
volume;

}

table.commit(columnConcentration);

13.14.6 Helper Classes and Functions

CsvWriter

Constructor

• new CsvWriter(filename [, truncate])

Opens the file for writing. Takes filename as para-
meter and an optional bool value if the file should
be truncated.

Member Methods Following methods (function prop-
erties) are defined on a CsvWriter object:
• separator (property)

Column separator (by default “\t” - TAB)
• endOfLine (property)

End Of Line (by default “\r\n” - Windows style)
• close()

Closes the file.
• writeValue(value)

Writes the value (nothing more).
• writeSeparator([sep])

Writes Column separator. If not supplied the separ-
ator property is used.

• writeValues(array [, sep])

Writes whole line using the values in the array sep-
arated by sep or separator property and followed by
the End Of Line.

• writeEndOfLine()

Writes End Of Line.
• writeTextLine(text)

Writes the text followed by End Of Line.

Example:

var f = new CsvWriter("c:\\data.csv",
true)

f.writeValues([1.1, 2.1, 3.1])

f.writeValues([1.2, 2.2, 3.2])

f.writeValues([1.3, 2.3, 3.3])

f.writeValues([1, 2.0, "abc"])

f.close()
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CsvReader

Constructor

• new CsvReader(filename)

Opens the file for reading. Takes filename as para-
meter.

Member methods Following methods (function prop-
erties) are defined on a CsvReader object:
• separator (property)

Column separator (by default “\t” - TAB)
• endOfLine (property)

End Of Line (by default “\r\n” - Windows style)
• close()

Closes the file.
• bool = isAtEnd()

Returns true if there are more data to be read.
• text = readTextLine()

Reads the whole line.
• array = readValues([sep])

Reads the whole line separated by sep or separator
to the array.

var f = new CsvReader("c:\\data.csv")

while (!f.isAtEnd())

{

r = f.readValues() trace(r.toString())

}

Macro functions

int execProgram(command), int execProgram-
Wait(command)

Both function take one string parameter with execut-
able command. The second function waits until the

program terminates. See the documentation about
macro functions Int_ExecProgram() and Int_ExecPro-
gramWait().

trace (text)

The function logs the text into debug window and into
NIS-Elements Log File.

int messageBox(message [, caption [, buttonFlags]])

Displays a message box with given message. Optionally
caption and button flags may be specified. The values
for the buttonFlags have the same value as for Win-
dows MessageBox function.

double timeCounter()

Returns actual time, suitable for measuring execution
time (see The code example 1).

Code Example1:

var tableObject = new ObjectTable
(["frame.index","CellCountAnalys-
is.DAPI.MaxFeret", "CellCountAnalys-
is.DAPI.MinFeret"], "jobrun.ID = 116",
"frame.index ASC");

var tableFrame = new FrameTable
(["frame.index", "CellCountAnalys-
is.DAPI.Count"], "jobrun.ID = 116",
"frame.index ASC");

var columnFeret = tableFrame.ad-
dColumn("FeretMean");

var i = 0;

var start = timeCounter();

for (frameRow in tableFrame)

{

tableFrame[frameRow][columnFeret] = 0;

}

for(objRow in tableObject)

{
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if(tableObject[objRow][0] == i)

{

tableFrame[i][columnFeret] += tableOb-
ject[objRow][1]/tableObject[objRow][2];

}

else

{

tableFrame[i][columnFeret] /= table-
Frame[i][1];

tableFrame[i+1][columnFeret] +=
tableObject[objRow][1]/tableOb-
ject[objRow][2];

i++;

}

}

var end = timeCounter();

tableFrame.commit(columnFeret);

messageBox(end - start);

Code Example 2:

var a = [

[1.1, 2.1, 3.1],

[1.2, 2.2, 3.2],

[1.3, 2.3, 3.3],

[1, 2.0, "abc"],

]

var f = new CsvWriter("c:\\data.csv",
true)

f.writeValues(a[0])

f.writeValues(a[1])

f.writeValues(a[2])

f.writeValues(a[3])

f.close()

execProgram("Notepad.exe c:\\data.csv")

if (messageBox("Do you want to read-
back the data?", "Question", 0x24))

{

var i = 0

f = new CsvReader("c:\\data.csv")

while (!f.isAtEnd())

{

r = f.readValues()

trace(r.toString())

if (r.equals(a[i]) == false) // equals
must be defined messageBox("Row does
not match")

i++;

}

}

13.15 Task reference

A detailed description of each task can be found here.

13.15.1 Well Plates

Define Plate

This task specifies shape and size of a well plate as
well as the working area of single wells.
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Well Plate name Type the name of your well plate.

Select from DB... This button opens the well plate
database, where you can find many standardised well
plates.

Note

Type your well code into the Search field to find
your well faster.

Custom Well Plate... This function opens the Define
customwell plate window where it is possible to adjust
all key parameters of nonstandard well plates. Please
see Custom Well Plate Options.

Align Well Plate... Opens the Align Well Plate dialog
window. Please see Align Plate .

Note

Well plate alignment can be done inside the job
definition using the Align Plate and is job
dependent - has to be repeated with each new
job. It is also possible to align the plate globally
by HCA/JOBS > Well Plate > Align Well Plate. This
alignment is saved into the database and applied
on new wellplates automatically.

Custom Well Plate Options

Plate name Type the name of your well plate.

Rows Type how many rows does your well plate have.

Columns Type how many columns does your well plate
have.

Well shape Select which shape does your well plate
have. Circular, Rectangular and Rounded Rectangular
are available.

Well names Here you can choose the single well la-
beling method. The Per axis method enables labeling
the wells with letters and numbers, applicable on both
axis. The Per wellmethod labels the wells from number
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one, from the left side to the right side and from top
to bottom. Specify your choice in the Column and Row
combo box.

Plate length, Plate width Define size of the wellplate.

Column spacing, Row spacing Define distances
between adjacent well rows.

Row offset, Column offset Define distances from the
edge of your plate to the center of the A1 well.

Well diameter Define the diameter of a single circular
well.

Well height, Well width In case of rectangular well
shape, define its height and width.

Corner Radius If you are using a Rounded Rectangular
well shape, here you can set the corner radius in [mm].

Column, Row In Per axis mode this function assigns
either letters or numbers to all columns and rows.

Select Wells

This tool specifies which wells of the selected well plate
are actually used in the experiment. Before selecting
any wells you need to define the well plate by the
Define Plate task. After the plate definition, you
can select the wells using the Select Wells task. The
wells can be easily selected by clicking and dragging
over the well board. If you hold down the shift key, you
can select remote parts of the well plate. If you hold
down the control key and drag over wells already se-
lected, you exclude them from your actual selection.
You can also select single rows / columns by clicking
on their letter / number. If using mouse for the well
selection, the selected values automatically appear in
the Select rows or Select columns fields where you
can manually rewrite them using comma (for separat-
ing the values) and dash (for entering range values).

Name of the Selection Type the name of your well
selection.

On Well Plate Here you can switch between different
well plates created in your actual job.

Selection color Choose any color you wish. This color
is then going to be used to visualize the wells selected.

Well Ordering This function defines the order in which
the wells are passed (e.g. during a Loop). Meander
(the most effective way of moving between wells), Left
to Right and Top to Bottom options are available.

Select all Selects all wells from a chosen well plate.

Select Rows
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Enter a single row or a range of rows that you want to
select.

Select Columns

Enter a single column or a range of columns that you
want to select.

Loop Over Wells

Runs the contained tasks on each well of the selected
well selection.

Loop Type the name of your loop.

over Switch between different well selections available
within your job.

Split storage per well This option influences how the
system stores the captured data on the disk. If

checked, separate ND2 file will be created for each
well.

Use Wells with ... Label If your wells are labeled (by
the Label Wells task), you can loop only over wells
marked with the selected label.

Advanced If you select this option, the Loop over wells
will be performed only on wells with defined class typed
in the Loop over wells in class field. The class number
can be assigned to each well using an expression. The
Class can be defined in the Expression task - find
a parameter named “Class” under Job / Name of your
Well Loop / CurrentWell / Class. Insert this expression
by double-clicking on it and use given operators to
define your class (e.g.: Job.WellLoop.Current-
Well.Class=2). In our case “2” is the Class we fill into
the Loop over wells in class field.

Note

Loop overWells does notmove between the wells
on a well plate by itself. It is therefore impossible
to expect pictures of single wells by placing just
Capture inside the Loop over Wells. To do so, you
have to place theMove toWell Center task ( Move
to Well Center ) inside the loop right before
capture. This task tells the loop to move to the
appropriate well.

Label Wells

Enables to label, add a description or metadata to
each well or a group of wells.
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Unfold your Label Wells task inserted into the
Job definition window by double clicking on its caption
and click Define... to open the Labeling/Quantities
window (see: Labeling/Quantities window).

Align Plate

This function determines the exact position of a well
plate on the XY stage. Typically, this task is executed
during runtime.

Correct Wellplate Alignment - Well Calibration

For a precise alignment, at least two wells should be
calibrated. Each well is calibrated using one or more
points based on its shape and selected calibration
method. To align your wellplate correctly follow this
procedure:

1. Select a calibrating Method from the combo box
(defines how many points have to be added for each
well).

2. Choose a well in the wellplate preview and click on
in (Recommended Wells are coloured in gray).

3. Display live image from the camera. A cross will be
displayed in the image.

4. Move the XY stage so that the edge/center/corner
(based on the chosen method) of the well is in the
center of the cross.

5. Click Add .
6. Now use the stage to add more edge points on the

same well (add as many points as you selected in
the Method combo box; e.g. for Center Point one is
sufficient). If all calibration points of a single well
were correctly added, the well is highlighted green.

7. Choose a second well in the wellplate preview and
click on it.

8. Add calibration points for this well (repeat procedure
from step 3).

9. If done properly, two wells are calibrated (high-
lighted green) and the well plate is correctly aligned.
To increase accuracy of the alignment, calibrate
more than two wells.

Note

The more wells you calibrate, the more well plate
alignment imperfections are eliminated. Two
calibrated wells can rectify the XY position and
rotation of the well plate. Three calibrated wells
can rectify the XY position and a slight tilt of the
well plate. Four calibrated wells can rectify the
XY position and a large tilt.
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However one well is also enough for rough calib-
ration. If one well is used for calibration it is as-
sumed that the whole well plate is placed ortho-
gonally on the stage with its top-left well oriented
to the top-left stage corner.

Align Wells tab

Name Type the name of your align.

Align Choose a well plate defined by the Define Plate
which will be aligned.

Method Specify the calibration method based on the
number and position of the calibration points on the
currently calibrated well.

Add Adds point coordinates into the well alignment
table.

Remove Removes the selected XY coordinate.

Remove All Removes all points from the alignment
table.

Test Well Select a calibrated well and click this button
to move to its edge. This way you can check the correct
edge calibration.

Test tab

This tab is useful for checking the correct alignment
of the whole well plate. Hover the cursor over any well.
Available test move locations are displayed. Click on
a gray circle to move the stage to this exact position
and verify the alignment precision.

Plate Loader

This task communicates with the well plate loader
connected to your system.

1) Click the Initialize button and follow the instruc-
tions to initialize your plate loader.

2) Scan for the loader hotels by clicking the Scan
Hotels button.

3) Select / deselect the plates and hotels found to
be used in your job.

4) Add notes to each of your plates if necessary.

Other dialog options are similar to Manual Plate List
.
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Manual Plate List

Specifies the list of well plates to be used in a loop
over well plates. These well plates are changed
manually.

Manual plate list name Name your manual plate list.

Wellplate definition Select a well plate to be looped.

Use Well Plate Holder If using a well plate holder, you
can adjust the well plate offset from the first well plate
in the table.

First Plate is Already on Stage Check this option if
your first plate is already on stage.

Add New Plate Adds a new plate to the table.

Remove Removes the selected plate.

Remove All Removes all plates in the table.

Plate # Automatic sequence number of your well
plates.

Name Name of your well plate.

Barcode Here you can enter your own barcoding for
each well plate.

X Offset from Plate #1 X axis offset from plate 1.

Y Offset from Plate #1 Y axis offset from plate 1.

Notes for ... In the blank window below the well plate
ordered list you can fill out any other information about
each of your currently selected well plates.
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Loop over Plates

Runs the contained tasks on each well plate of the
specified list of plates. The list of plates is defined by
the Manual Plate List or Plate Loader tasks.

Loop Name your plate loop.

over Choose a plate list from your current job.

Move to Well

Moves the XY stage to a particular well of the specified
well plate.

Task name Name your move task.

Wellplate Select a well plate for the move definition.

Well row Define a row position where to be moved.

Well column Define a column position where to be
moved.

Move to Z If checked, the Z-drive moves to the Z posi-
tion assigned to the current well (e.g. Z value found by
Autofocus during the first Loop Over Wells ).

Use well PFS offset These options tell the system to
set the Z drive to a position previously assigned to the
current well.

Note

Particular Z drive position can be assigned to
each well by the Assign current Z to Point/Well

or Assign PFS to Point/Well tasks used
within Loop Over Wells . The check boxes
refer to this Z coordinate.

Move to Well Center

Moves the XY stage to the center of the current well.
This task can be used with a slide ( Define Slide ),
stage area ( Define Stage Area ) or inside a Loop
Over Wells .

Move to Select a sample holder used in your current
job.

Move to Z If checked, the Z-drive moves to the Z posi-
tion assigned to the current well (e.g. Z value found by
Autofocus during the first Loop Over Wells ).

Use well PFS offset These options tell the system to
set the Z drive to a position previously assigned to the
current well.

Note

Particular Z drive position can be assigned to
each well by the Assign current Z to Point/Well

or Assign PFS to Point/Well tasks used
within Loop Over Wells . The check boxes
refer to this Z coordinate.
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Move to Previous/Next Well

Moves the XY stage to the previous/next well. This task
can be used with a condition during runtime, e.g. when
there is a need to get to the previously treated well.

Task name Name of your task.

Move from Select the well from which you want to
move.

to Specify the moving distance to the previous/next
well.

Previous/Next well Choose the direction you want to
move.

13.15.2 Sample Holder

Define Slide

Specifies the dimensions of a slide including its work-
ing area.

If you use a standardized slide, click Select from DB...
and search for your slide in the slide database.

For non-standard slides, click Custom Slide... and
define its properties (width, height). If you use slides
with alignment crosses, it is recommended to check
Alignment Crosses and set their X and Y Offset for later
precise alignment.

Once you have selected/defined your slide, you have
to specify its orientation on the stage. The orientation
can be defined by Label Area Position, Smear Direction
or Crosses Position. Select the real Orientation of the
slide from the combo box.

At last it is possible to limit working area of the slide.
This area can be a Rectangle or a Circle defined by
Dimensions or using the Interactive feature which re-
quires to Add XY points lying on the border of the se-
lected shape (3 corner points for the rectangle or 3
edge points for the circle).

After defining the slide it is ready for alignment. Please
see: Align Slide .

Holder

This task defines the slides contained in a slide holder.
Start by clicking Redefine holder or go to HCA/JOBS
> Slide Holder > Align Slide, check AllowMultiple Slides
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and specify their count. Click Next and follow the
alignment steps until all slides are aligned. Then click
Select... on each row of the table to specify the slides
being used.

Redefine holder Enables to redefine and realign the
slide holder.

Select Opens the Select Slide dialog window enabling
to add a custom/system slide.

Deletes the selected slide from the list.

Define Stage Area

In this task you can specify the area of interest on your
stage holder.

Name Type the name of your stage area task.

Shape Select the shape of your stage area.

Define by Define the selected shape. If using a Circle,
it can be defined by Setting Center Position and Radi-
us or by Adding 3 Edge Points. If using a Rectangle,

you have to Add two opposite corners or three corner
points..

Align Slide

This task determines exact position of the selected
slide on the XY stage. Select a slide from the combo
box, move your stage to one corner of your slide and
click Add . Move the stage to the Opposite Corner and
click Add . Alignment is now finished. Changes to the
alignment can be done by removing the XY coordinates
clicking Remove or Remove All.

Name Name of the Align Slide task.

Slide Select slide for alignment.

Add Uses the stage coordinates as corner points used
for alignment of the slide.

Remove Removes the selected coordinate.

Remove All Removes all coordinates used for slide
alignment.

Note

Slides can also be aligned globally using
HCA/JOBS > Slide Holder > Align Slide. This
alignment is saved into the database and applied
on new slides automatically.

Slides with covered corners

If your slide is mounted to the stage in a manner that
its corner(s) are not visible in the Live View, it is im-
possible to align it using the predefined slides from
the database. In this scenario there are two options:
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• Create a custom slide (using Define Slide ) with
Alignment Crosses and use these crosses to target
corners of the coverslip, visible corners of the slide
or any other reference points.

• Use Define Stage Area with a rectangular
shape and find corners of the coverslip, visible
corners of the slide or any other visible reference
points.

Manual Slide List

Specifies the list of slides to be used in a loop over
slides. These slides have to be changed manually.

Manual slide list name Name of your manual slide
list.

Slide definition Select the slide definition ( Define
Slide ).

Use slide holder If using a slide holder, you can adjust
the slide XY offset from the first slide in the table.

First slide is already on Stage Check this option if
your first slide is already on stage.

Add New Slide Adds a new slide into the table.

Remove Removes the selected slides.

Remove All Removes all slides from the table.

Slide # Automatic sequence number of your slides.

Name Name of your single slides.

Barcode Here you can enter your own barcoding for
each slide.

X Offset from Slide #1 X axis offset from slide 1.

Y Offset from Slide #1 Y axis offset from slide 1.

Notes for ... In the blank window below the slide
ordered list you can fill out any other information about
each of your currently selected slides.

Slide Loader

(requires: Local Option)

This task communicates with the slide loader connec-
ted to your system.

1) Click the Initialize button and follow the instruc-
tions to initialize your slide loader.

2) Scan for the loader hotels by clicking the Scan
Hotels button.

3) Select or deselect the found slides and hotels to
be used in your job.

4) Add notes to each of your slides if necessary.
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Loop over Slides

Runs the contained tasks on each slide of the specified
slide list. The list of slides is defined by the Manual
Slide List or Slide Loader tasks.

Loop Name your slide loop.

over Choose a slide list from your current job.

Loop over Holder

Runs the contained tasks on each slide in the specified
Holder .

Name Name of the Loop over Holder task.

Loop over Select the Holder over which the loop
will be performed.

13.15.3 Time Series

Time Lapse

Repeats the contained tasks according to the specified
parameters (total duration / number of loops, inter-
val...). This task typically contains just the Capture

task, but can contain any meaningful task as well.
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Loop Type the name of your loop.

Total Duration Select one of the following time lapse
modes:

Time Set a precise amount of time to be used as
the Timelapse duration [msec / sec / min /
hour(s)].

Number of Loops Define the number of loops
(how many times will the containing tasks ex-
ecuted).

Unknown (User or Program Break) Use this
function if you don't know when to stop the time
lapse. With this setting it can be stopped manually
or automatically after a program break.

Acquisition Period Select No-delay to let the task run
as fast as possible. Two other options specify a time
interval between two adjacent repetitions of the task.
Run Loop Every option specifies how fast the tasks
are started.Wait Between Loops defines a time pause
between the end of one loop and the beginning of the
next one.

Split Storage per Time point If checked, each time
loop is stored in a separate nd2 file.

Run Tasks while Waiting Other tasks can be per-
formed repeatedly if there is a spare time between two
adjacent loops. When you check this option, additional
space namedRunwhile waiting appears at the bottom
of this task. Place the tasks which you want to run
while waiting for the next loop into this area.

Finish when condition is TRUE Especially if a time
lapse with Unknown total duration is defined, you can
specify a conditional expression which will cause the
loop to be discontinued. Click Define to specify the
conditional expression (Please see 13.13.3 Using Ex-
pressions).

Time Lapse

Modifies an existing Time Lapse. This task is usually
used within a Condition - if something happens, re-

define Time Lapse (e.g. increase frame rate). See Time
Lapse for description of the task options.

Time Sequence

Chains acquisition time-phases and phases of different
types (temperature / gas control, perfusion control).
Please see the 5 Time-lapse Acquisition chapter for
description of the task options.

Repeat N times

Repeats the contained tasks for the specified number
of iterations or indefinitely until Break .

Name Type the name of your repeat task.

Repeat Here you can choose from the following op-
tions:

Number of iterations Insert a number to define
how many times the tasks will be repeated.

Undefined number of iterationsUse this function
if the loop will be exited either by the Break
task or by the Finish when condition is TRUE op-
tion.

Finish when condition is TRUE You can specify a
conditional expression which will cause the loop to be
exited. Click Define to specify the conditional expres-
sion. See also 13.13.3 Using Expressions.
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Keep Object In View

(requires: Local Option)

This function finds the object of interest based on the
correlation between the previous and the next frame
and always keeps it in the center of view using the
microscope stage to compensate the object's motion.

Action:MoveWith The StageMoves the stage to keep
the object in view.

Action:Move and Update Point's CoordinatesMoves
the stage to the current center of the object and up-
dates coordinates of your points defined in different
tasks (e.g. Loop over Points defined by Generate
Points ).

Select Capture Source: Select the source from which
the image will be taken.

Select Channel for Tracking: Select the channel which
will be used for following the object.

13.15.4 Stage XY Points

Generate Points

Creates a pattern of XY points on the selected sample.

Main settings of this task are described below, however
some settings enable advanced adjustments (e.g. size,
distance, count,...). These functions are self-explanat-
ory and are clearly depicted in the preview area.

Point Set Name Type the name of your point set.

On Select on which sample holder to generate the
points.

Working area Define the working area of the sample
holder.

Field Size Actual at Run-Time uses the field of the
currently used objective. Points are generated using
the objective set right before the job run. Custom can
be used to select a specific objective from the combo
box which is then always used for the point generation.

Camera If multiple cameras are connected, select the
one to be used with this task.

Objective Objective to be used for generating points.

Area Restriction Specify the restriction inside the
working area.
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Point Placement Choose one of the point placement
methods listed.Manualmethod enables to add points
by clicking into the preview area. Created points can
be moved using the primary mouse button. Right-
clicking deletes the point below the cursor.

Scan Direction If Point Placement is set to Random,
Random+Center or Manual, Random scan direction
scans in the randomized order whereas Optimal Path
scans points in the most effective order.

If Covering or Regular Pattern point placement is se-
lected, Meander scans in a winding manner and Left
to Right scans row by row from left to right.

If Point Placement is set to Spiral, options in the Scan
Direction combo box specify the direction of rotation
(ClockWise/CounterClockWise) and heading from/to
the center (Outwards/Inwards).

Frames on Border Specify whether the frames on the
border of the restriction area are touching the border,
completely inside or having a center inside.

Overlap In Covering mode you can select the frame
Overlap amount in percent.

Count Set the number of points you want to generate.
The maximum number is indicated in the bracket.

Distribution Uniform places points evenly and Prefer
Center places most of the points into the center of the
restriction area.

Always Create NewPoints There is always a new point
set generated whenever the task is performed.

Randomize Regenerates your random points.

Predefined Points

Using this task, you can specify a list of XY points on
the selected sample manually in a tabular way. Please
see 6 Multi-point Acquisition for details about points
predefining. There are some additional options avail-
able within the JOBs module:

Include Z-StackDisplays the Z-Stack definition column
with the Z-stack definition button enabling to
define a Z-Stack for the currently selected point.

Include Camera SettingsDisplays the Camera column
with the Redefine Camera Setting button enabling
to adjust the camera settings (please see: Adjust
Camera Settings Manually in OC ).

Include Stimulation ROIs DefinitionDisplays theROIs
column with the button. Click this button and
draw stimulation ROI(s) for the selected multi-point.

Include Labels Labels defined in Label Wells
task can be assigned to each multi-point. Select a label
from the pull-down menu in the Label column.

New Point Set

Creates an empty point set. Points shall be added to
it later either by Add Point to Point Set or
Add/Edit Points Manually .

Point Set Name your point set.

Loop over Points

Runs the contained tasks on each XY point of the se-
lected point set.

Loop Name your point loop.

65

JOBS and HCA



over Select one of your active point tasks to be looped
( Generate Points , Predefined Points , New
Point Set ).

Split storage per point This option influences how the
system stores the captured data on the disk. If
checked, separate ND2 file will be created for each
point.

Move to XY If checked, the stage is moved to the XY
points.

Move to Z If checked, the Z-drive moves to the Z posi-
tion assigned to the current well (e.g. Z value found by
Autofocus during the first Loop Over Wells ).

Use well PFS offset These options tells the system to
set Z drive to a position previously assigned to the
current point.

Advanced Each point can be assigned to a class (by
an expression). If you select this option, the Loop over
wells in class field appears. Type the class number to
which the current loop will be applied.

Use Points with Label If you select a label defined by
the Create Labels task, the tasks inside Loop
over Points will be executed only on points marked
with this label.

Move to Point

(requires: Local Option)

This task can be used inside Loop over Points to
move to a XY/Z position of a point.

Move to Defines in which point loop the movement
will be performed.

Move to XY Moves to the XY coordinates of the point.

Move to Z Moves to the Z coordinate of the point.

UseWell PFS Offset PFS Offset of the well is incorpor-
ated into the movement.

Move to Previous/Next Point

Moves the XY stage to the previous/next well.

Task name Name of your task.

Move from Select the point from which you want to
move.

to Specify the moving distance to the previous/next
point.

Previous/Next point Choose the direction you want
to move.

Offset Point Set

This task can correct the XY offset between objectives
and can be used to offset all XYZ coordinates of the
current stage position or of the selected point set.

X, Y, Z shift Name of the task.
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of Is used to select a point set ( Generate Points ,
Predefined Points , New Point Set ) or the
Actual Stage Position to be shifted.

X, Y, Z Specify distances of the shift in all three axes.

Correct XY Offset between Macro and Scanning Ob-
jective If checked, XY correction between objectives
is performed using the two objectives specified below.
Please see Devices > Objectives XY Offset Setup for
more information.

Define Offset Manually Specify distances of the
manual shift in all three axes (X, Y, Z).

Add Point to Point Set

Adds a named XY point to the selected point set. Cur-
rent XY position is used.

Name Name your new point.

Add current stage point to Select a point set to which
you want to add a new stage point.

Remove Point from Point Set

Removes the current XY point from the selected point
set which is used in a point loop. For example you can
use this task in an XY point loop to remove points
which are not useful for further analysis (e.g. do not
produce any image signal).

Remove Point Select an active point loop from which
your point will be removed.

Add/Edit Points Manually

Waits for the user to add or edit points to the selected
point set manually during the runtime.

Name Enter the name of your manually defined points.

Embed to progress window Check this function if you
want to embed the Edit Points window into the bottom
of the Job Execution Progress window.

Point set Select a point set which you want to edit
manually.

Append Point Set to Point Set

Appends points from a selected point list into another
selected point list.

Name Name of your task.

Append all points from All points from this list will be
appended.

to Defines to which point list will the points selected
from the first combo box be appended.

Clear Point Set

Removes all points from the selected point list.
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Name Name of your task.

Remove all points from Select the plate list which will
be cleared.

Export Point Set to ND

Exports the selected point set definition to the ND Ac-
quisition window.

Point set to export Select the point set you want to
export to the XY tab of the ND Acquisition window.

Append points Adds new generated points to the the
XY tab of the ND Acquisition window right behind
already existing points.

Replace points Replaces all existing points in the XY
tab of the ND Acquisition window by newly generated
points.

Import Point Set from ND

Imports the multi point definition from the ND Acquis-
ition window to the selected point set. The existing
point set settings will be overwritten.

Import to point set Select a point set to which data
from the ND Acquisition window will be imported.

Append points Adds newly generated points to your
selected point set behind already existing points.

Replace points Replaces all existing points in your
point set by newly generated points.

13.15.5 Large Images

Scan Large Image

Task enabling to scan large images using precise
parameters.

Name Name of your task.

Scan using Select a Capture Definition and
specify its objective from the combo box (with ... object-
ive).

Save Image Choose whether or not to save the ac-
quired images.
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Fields Define the field dimensions of the large image.

Placement Around the Current Position places the
corners of the fields directly next to the current stage
position. Current Position is at Top-Left Corner uses
the stage position as a position of the top-left field.

Use Captured Shading Correction Shading correction
saved with the Optical Configuration can be used. Se-
lect your Optical configuration, select Acquire > Shad-
ing Correction > Shading per Optical Configuration and
then go to Acquire > Shading Correction > Capture
Correction Image to capture the shading correction.
Now you can check the Use Captured Shading Correc-
tion check box.

UseAutomatic ShadingCorrection Automatic shading
correction can be used checking this function. Choose
the type of correction which best represents your
sample - Brightfield, DIC like or Fluorescence with off-
set enabling to heighten brightness level of the correc-
ted image to make objects in dark areas more visible.
Remove dust compares all frames, searches for a re-
peating pattern (e.g. dust, objective scratches) and
removes it.

Overlap and Stitching This area contains parameters
defining the overlap size, stitching mode (blending or
optimal path) and a channel which is used for the
stitching. Precise stitching (Image Registration) can
be checked but be aware that it is more computation-
ally demanding.

Focus Autofocus can be used checking this function.
Select a Autofocus Settings and choose where
in the large image it will be performed (every Nth field
or after a specified stage distance).Autofocusing on
Frames without sample can be skipped.

Use Focus Surface Focuses using the surface defined
in the Focus Surface tab of the View > Acquisition
Controls > XYZ Overview panel.

Scan Large Image in Slide/Well/Area

This task scans large images on a sample holder (slide,
stage area or well).

Holder Specifies your sample holder.

Border restriction Enter an optional border restriction
on your sample holder.

Center restriction Enter an optional center restriction
on your sample holder.

Please see Scan Large Image describing other
parameters which are similar to this task.

Scan Large Image in Region

This task is used to scan large images on a predefined
set of regions. Regions can be generated automatically
using General Analysis or drawn manually on a
captured image or a large image. Place this task inside
Loop over Regions .
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Region Loop over Regions in which this task is
placed.

Correct Objectives XY Offset This feature corrects the
XY offset previously set in Devices > Objectives XY
Offset Setup.

Please see Scan Large Image describing other
parameters which are similar to this task.

Draw Regions

This task is used to manually draw regions during ac-
quisition. Once the capture is made, the job is paused
and Simple ROI Editor is shown over the Draw Regions
window. Please see ROI > Simple ROI Editor for more
details about drawing regions. Once you finish the
drawing, click Finish to continue the job.

Name Name of your Draw Regions task.

Manually draw on Select a capture on which the re-
gions will be drawn.

Region Division Regions can be treated Per Frame -
all drawn regions are considered as one area in the
particular frame, or Per Object - each region is treated
as a single object.

Window size Depending on your preference, choose
one of the three window size options: General options
(exerts the last used window size), Tiled view (tiles the
live window alongside with other windows) or Maxim-
ized (Maximizes the live window).

Window position If using multiple monitors, this
function can put your Draw Regions window onto your
Second screen, keep it on the Main screen or embed
it directly into the Progress dialog.

Shift Region

When Multimodal Image Registration (Image > Chan-
nel Alignment and Registration > Multimodal Image
Registration) is used (e.g. for comparing images from
SIM and Confocal), shift of the regions can be made
using this task.

Name Name of your Shift Region task.
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Shift Select on which regions the shift will be per-
formed.

for acquisition with Select an Optical Configuration
from which the shift values are taken.

Figure 12.427. Typical example using Shift Region
to compensate the shift between C2 andNSIM

capture:

The job defines one Capture Definition for C2
which is used to Capture an image on which re-
gions are defined using Draw Regions . Then the
job loops over these regions automatically compensat-
ing the shift ( Shift Region ) between two registered
systems (stored in Image > Channel Alignment and
Registration > Optical Path Corrections). Move to Re-
gion Center moves the stage to the center of each
region and captures an image using NSIM Cap-
ture.

Edit Regions

(requires: Local Option)

Enables to edit regions during the job. The job is
paused and Simple ROI Editor is shown. Please see
ROI > Simple ROI Editor for more details about drawing
and editing regions. Once you finish the edits, click
Finish to continue the job.

Name Name of your Edit Regions task.

Edit regions of Select which regions are to be edited
(e.g. from General Analysis or from DrawRegions

).

Window size Depending on your preference, choose
one of the three window size options: General options
(exerts the last used window size), Tiled view (tiles the
live window alongside with other windows) or Maxim-
ized (Maximizes the live window).

Window position If using multiple monitors, this
function can put your Draw Regions window onto your
Second screen, keep it on the Main screen or embed
it directly into the Progress dialog.

Region List

This task is used as a blank list which can be filled with
regions inside General Analysis Calculations tab
(please see 2.5 General Analysis).

71

JOBS and HCA



Name Name of your task.

Loop over Regions

This task can be used to execute contained tasks over
a set of regions in a loop.

Loop Name of your task.

over Selected Region List task containing regions
for the loop.

Move to Region Center

Moves to the center of the region. This task is placed
inside Loop over Regions .

Move to Center Position of Defines in which Loop
over Regions the movement to the center of a
region will be performed.

Append Region List to Region List

(requires: Local Option)

Adds selected regions to the selected region list.

Name Name of your Append Region List to Region
List task.

Append all regions from Defines which regions are
used for appending the region list.

Clear Region List

(requires: Local Option)

Deletes regions from the selected region list.

Name Name of your Clear Region List task.

Remove all regions from Defines which region list is
to be cleared.

13.15.6 Z-Stack

Define Z-Stack

This task defines parameters required for capturing a
Z-Stack (a sequence of images each having a different
focal plane). Z-Stack can then be used to create all-in-
focus images or 3D models regardless of your sample
and depth of field parameters. Please see the 7 Z-
series Acquisition chapter for details about the Z-stack
setup.
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Figure 12.434. Defined by top bottom mode

Figure 12.435. Symmetric mode defined by range

Figure 12.436. Asymmetric mode defined by range

Z-Stack Name of your Define Z-Stack task.

Defined by top bottom This mode defines the Z-
stack using two parallel planes ( Top and
Bottom).

Required values: top position, bottom position, step
size or number of steps.

Symmetric mode defined by range This mode
defines the Z-stack by its center (Home) position and
the same range above and below the Home plane.

Required value: range.

Asymmetric mode defined by range This mode
defines the Z-stack by a center (Home) position and a
custom range above and below the Home plane.

Required values: above position, below position.

Top Sets the top Z position.

ResetDiscards the Top, Home, and Bottom position
settings.

Relative Changes the Home (absolute Z) position
to Relative (current Z position deducted prior to the
actual acquisition).

Home In the Symmetric / Asymmetric mode
defined by range this button sets the position in the
middle of your range.

Bottom Sets the bottom Z position.

Step Define the range of a single step.

Use suggested step size Click this button to use
the recommended step size.

Steps Insert the number of steps you want to acquire.

Bottom Set the bottom Z position manually.

Top Set the top Z position manually.

Z Device Choose a Z device used for Z-stack acquisi-
tion.
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Piezo Specifies the role of the Piezo Z drive.

Range Enter the range of the final Z-stack (in-focus
portion of your sample).

Below Set the bottom position of the Z-Stack manually.

Above Set the top position of the Z-Stack manually.

Direction Enables to set the Z axis direction in which
the stage will move during acquisition.

Z-Stack Loop

Repeats the contained tasks for each Z position of the
selected Z Stack. This task can be used inside any
other loop (time-lapse, point set) with Capture .
It captures Z stacks to extend spatial resolution of the
image sequence.

Assign Z-Stack to Point/Well/ND Acquisition

Every XY position (well, row of wells, column of wells)
can have unique Z stack parameters assigned by
combining Define Z-Stack and Assign Z-Stack to
Point/Well/ND Acquisition tasks.

Assign Z-Stack definition Select your Z-Stack defini-
tion for the assignment.

Offset Add an optional Z offset on top of the Z-Stack
definition.

to Select to which the Z-Stack definition will be as-
signed. If a second combo box appears (e.g. when us-
ing well plates) - specify your selection.

Move to Z-Stack home

Moves the Z drive to the home position of the selected
Z Stack Definition. When capturing multi-channel Z-
stacks, not all the channels are required to contain
the Z dimension. These are usually captured in the
home (center) position.

Move to Home of Choose your Z-stack definition from
your current job.

13.15.7 Autofocus + Focus Surface

Autofocus Settings

Defines Z device settings to be used by the Autofocus
task. Different AF settings may be defined for

different purposes. Settings of this task have many in
common with the Devices > Auto Focus Setup com-
mand.

Select a method you will use:

Step by Step This method moves the Z drive in steps
within the defined range, captures images and evalu-
ates their focus criterion. The Z position with the best
focus criterion is used as focused.
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Continuous (requires Nikon Ni or Ti2-E microscope)
This method is similar to Step by Step except that in
this case, the step size depends on the camera frame
rate. The camera takes pictures as fast as possible
while the Z drive is moving within the defined range.

Name Name your autofocus setting.

Z Device Choose the Z drive to be used for focusing.
If you choose <fastest>, the Piezo Z will be used in as
many cases as possible. If its range is not big enough,
then the main Z device movement will be added to
reach the required absolute Z.

Criterion Defines which focus criterion is used:
• Brightfield - standard contrast based criterion - for

brightfield images
• Fluorescence - suitable for fluorescence microscopy

• Max sum intensity - criterion based only on the in-
tensity values. This is useful in confocal microscopy.

• Yeast, Bacteria (Ph) - a criterion optimized for yeasts
under phase contrast (Ph) microscope.

Use OC Select the optical configuration to be used for
focusing.

Offset Z after AF This option may be useful in fluores-
cence applications for the cases where the auto focus
algorithm produces offset (the system states it is fo-
cused but you would like to focus on some other ob-
jects within the image, which are blurry). After perform-
ing auto focus, the Z drive will move by the distance
[µm] defined within this field.

Exclude Border This function enables to exclude the
border of the image and use only the central part for
focus. Width of the excluded border can be set in the
edit box.

Move to Original Z on Failure If autofocus fails, the Z
drive moves to the original Z position.

Close active shutter during stage movement The
active shutter will close in times between acquisitions
phases. Typically, this option is used to reduce the
photo-bleaching effect on live cells.

Skip Focusing on Background (requires Back-
ground/Specimen detection to be set up) Speeds up
the focusing by omitting the background area. Please
see: HCA/JOBS > Background Detection > Teach
Background/Specimen Detection.

AF mode
Auto Automatic focus mode, only the range shall
be defined. The system calculates optimal step
and whether 1 pass or 2 passes will be per-
formed.

Manual Manual focusing mode enabling further
settings. The focusing range and step in the first
and second pass can be defined manually.

Range Define the total distance which the Z drive will
use for auto focus.
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Single pass Single pass performs auto focus in one
step. This is a standard auto focus method which can
be used.

Two passes This method is suitable when you are far
out of focus. It is performed in two steps: Coarse and
Fine.

Note

If the Continuous in range two-pass auto focus
fails the reason may be:
• Camera exposure time is not compatible (too
short or too long) with the speed of your Z drive.

• The automatically calculated coarse step is too
large and the specimen is thin so it does not
come into focus at all.

Try reducing the auto focus speed to Slow, adjust
camera the exposure time, or use the Single pass
mode.

Autofocus

Performs autofocus using the selected Auto Focus
settings defined in Autofocus Settings .

Focus Name your autofocus.

Using Select autofocus setting determined by the
Autofocus Settings task.

Note

If Autofocus task fails to focus, captured images
will be labeled with Focus Failed flag and will be
marked by a red circle in the Labeling view. Focus
Fail flag will not be assigned if Z coordinate is
modified by 10um or more after unsuccessful
autofocus.

Create Focus Surface

Calculates global focus surface from an existing set of
Z positions. The Z positions must be defined before-
hand e.g. by the Assign current Z to Point/Well
task.

Name Name your focus surface.

On Select the source Z point set from which the surface
will be calculated.

Compute Z-values from
Smooth interpolation surface Any position on
the resulting surface is a result of interpolation.

Nearest control point Z-value This is not really a
surface. In any XY position, Z value of the nearest
existing XY point is used.

Move to Focus Surface

Moves the Z drive to the position defined by the Create
Focus Surface task (or Offset Focus Surface

). Use it on each XY position within a point loop to
get the image into focus (or pre-focus).

Offset Focus Surface

Modifies an existing Focus Surface by adding / sub-
tracting an offset distance. You can use the focus
surface offset on each point for pre-focus and check
every N-th point whether the focus has not shifted. If
it has, shift (offset) the whole focus surface to match
the current focus.
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Offset byOffset your focus surface by a defined numer-
ic value.

Assign current Z to Point/Well

Assigns the current Z position to the selected XY posi-
tion of a sample. You can use this task inside a loop
after Autofocus to pre-define Z positions for fast
scanning.

Redefine Z on Select a sample holder on which you
want to set the current Z position.

Escape Z

This task escapes the Z drive to the lowest position to
avoid objective collision.

Refocus Z

This task uses the Z drive to perform refocus of the
image.

13.15.8 PFS

PFS On and Focus

Turns the Perfect Focus System (PFS) on and tries to
find the PFS focal plane. Make sure the Z drive focal
plane is not too far from the PFS focal plane otherwise
the task may fail.

If you checkOn fail, do the following, more actions can
be done when PFS fails. Auto focusing can be done
using a selected Autofocus Settings task or Z
stage can be moved Up/Down by a specified value.

PFS Off

This task switches the PFS Off.

PFS Offset from the current Z position

Finds a PFS offset for the current Z position and sets
it as the current offset. It ensure that exactly the same
Z level will be kept when PFS is switched on.

Auto PFS Offset Settings

This task defines settings to be used by the Find Auto
PFS Offset task. Select the optical configuration
to be used. Similarly to auto-focus, range can be
defined in the automatic mode, range and step for
single-pass or two-passes can be defined for the
Manual mode.
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Select the focus criterion based on the nature of your
specimen.

Find Auto PFS Offset

The PFS system searches for the most in-focus plane
and sets the PFS offset accordingly. This task uses
settings defined by the Auto PFS Offset Settings
task.

See 13.13.6 Creating PFS Surface for a sample use
case.

Assign PFS to Point/Well

Uses the current Z position to specify PFS offset for
the selected XY position (e.g. a well). You can use this
task inside a loop over XY points after Find Auto PFS
Offset .

Redefine PFS on Select one of your sample holder
positions.

Create PFS Surface

Calculates the global PFS surface from an existing set
of PFS positions. To XY positions without the PFS pos-
ition defined, the PFS position of the closest XY point
(which includes PFS position) is copied.

See also 13.13.6 Creating PFS Surface.

Compute PFS values from
Smooth Interpolation Surface Any position on
the resulting surface is a result of interpolation.

Nearest Control Point PFS Value Value of the
nearest control point position is taken.

Move to PFS Surface

Changes the current PFS offset value to match the
calculated PFS Surface.

Offset PFS Surface

Modifies an existing PFS Surface by adding / subtract-
ing an offset distance.

13.15.9 Acquisition

Capture Definition

This task defines the single-channel or multi-channel
acquisition settings.
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Select an optical configuration to be used to capture
each channel. Please see 8 Multi-channel Acquisition.

Specific options

FocusOffsetSometimes when using multiple channels
for acquisition, not all channels have the same Z posi-
tions with the best focus. Using one channel as refer-
ence, user can specify focus offsets for individual
channels. Therefore all channels are captured in focus
automatically.

Close Act. Shutter In addition user can control active
shutter individually for each channel. Check Close Act.
Shutter check box to minimize bleaching or uncheck
it to leave the shutter opened and thus speed up the
acquisition.

Live Opens the live image dialog window.

>> Focus Offset Setup This button reveals the Focus
Offset settings. If two or more Optical configurations
are used (e.g. when OC's use different objectives) an
offset between them can be defined. Click on the first
OC, click Live to see the live view of the selected OC,
focus (you can use AF for automatic focus) and set it
as Reference . Click on the second OC, click Set OC
to activate it (switch to its live view), use the up/down
arrows to focus and click Offset to assign the offset
distance from the first OC.

Capture

Performs acquisition according to the selected Capture
Definition . Large images can be acquired and an
analysis can be run upon capture.

Name Name of your capture task.

Using Select a Capture Definition task set previ-
ously.

Use Shading Correction Check this option to turn the
shading correction on.

Automatic postprocessing Click ... to specify the
Shading Correction Options. Please see the Ac-
quire > Shading Correction > Capture Correction
Image command for details on this topic.

Large Image Large image is acquired as a series of
overlapping images taken one by one in regular grid
of given dimensions. After acquisition, images are
stitched together into one big image.

Enter the grid dimensions and check if you want to
Use Image Registration. This function tries to find the
perfect match of the overlapping parts of images,
however it takes some time to compute.

Save Image to Database In this part of the Capture
dialog, you can define the image saving conditions.
Two options determining how to save the images to
the database are available: Always or Never or Later.

>> Advanced Z-stack settings When combining
multiple captured images together not all frames have
to be captured in the image file. For example: Capture
Z-stack with Capture1 and then capture only home
position with Capture2. Images from Capture2 will be
missing in other then home position of the Z-stack.
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Use ... for Missing Images in Z-stack Select Black for
missing images to be black, similarly select White.
Select Duplicate to duplicate captured image to all
missing images in the Z-stack.

ND Acquisition

Acquires an ND2 image according to the definition
specified within the task. For more information about
ND2 Acquisition please see 4 About ND Acquisition .

Fast Timelapse

This task uses the maximum capture speed of the
camera set in 1.2 Optical Configurations to acquire a
desired number of frames. The acquisition can be
triggered by a TTL Signal or it can start automatically.
The frames are then stored into an ND2 file. Sample
Storing should be faster when the Memory Only (RAM
memory) option is selected. Use the Max button
to get the maximum number of frames.

Triggered Experiment

(requires: RT Acquisition)

This task aggregates all necessary features used for
triggered acquisition.

Experiment Name of your Triggered Experiment.

Z Series (Large Image) / Large Image (Z Series)
Specify which procedure is done first and which is done
later. First option creates a full Z-Stack and Large Im-
age is created later on each Z plane. Second option
creates a Large Image on the first plane, then moves
to the second plane, etc.

Time Check this option if you want to specify the dura-
tion of your experiment. Number of loops and time per
one loop is indicated next to the combo box. Use Re-
fresh to update the loop/duration estimate.

Piezo Z stack Check this option if you want to capture
a Z stack. Specify the Step size and/or a Range, use
the Suggested Step Size or enter a number of
steps. Z direction can also be specified. Bidirectional
acq. moves the stage in both directions from the
sample, Towards sample scans in the direction to the
sample and Away from sample scans the Z stack from
the sample.

Piezo XY / Large Image (requires: Local Option)
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This option can be used for acquiring XY points or Large
Images. For Large Images enter the number of fields
or use the Full piezo range. Specify the image overlap
in percent. You can set whether you want to Create
Large Image or XYMultipoint. Register tries to find the
perfect match of the overlapping parts of images,
however it takes some time to compute. Point list can
be used for capturing multi points. For more informa-
tion about XY points, please see 6 Multi-point Acquisi-
tion.

Optical Conf. Enables to select which optical configur-
ation is used for the triggered experiment.

Acquisition details Displays additional information
about the adjusted experiment (e.g. used Objective,
Camera FOV and Large Image FOV).

Illumination Sequence

This task enables to set camera-to-device triggering
patterns. For more information, please see: 12 Illumin-
ation Sequence.

Live Window

This task displays, freezes or hides the live-signal
window. Use this tool whenever a preview of what is
happening under the microscope is needed.

Action Choose one of three live actions: Show Live
Window (opens a new preview window), Freeze (freezes
the preview) or Close LiveWindow (closes the preview).

Window size Depending on your preference, choose
one of the three window size options: General options
(exerts the last used window size), Tiled view (tiles the

live window alongside with other windows) or Maxim-
ized (Maximizes the live window).

Window position If using multiple monitors, this
function can put your Live window onto your Second
screen, keep it on theMain screen or embed it directly
into the Progress dialog.

Merge and Store Captured Images

Specifies the file-format used to store images created
by the Capture task. The recommended (and default)
setting is ND2 (the system tries to save images from
different loops to a single file if possible). If the cap-
tured data are to be processed by other software, set
the format to TIFF (Single or Multi-page).

Name Name your storage setting.

Save color channel data Choose a color channel
storage method - Pixel or Plane. The default is per
plane.

Note

This options may be useful for advanced users
who plan to further process the images in other
applications (such as MatLab). You can ignore it
if you use just NIS-Elements AR.

Detect Background

This task can detect background from captured im-
ages. It requires connection to a Capture task
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and it sets two properties (IsBackground, IsSpecimen)
for later use (e.g. in the Condition IF task).

Warning

This task requires Background/Specimen detec-
tion to be set up first. Go to: HCA/JOBS > Back-
groundDetection > Teach Background/Specimen
Detection.

Name Name your detect background task.

Detect Background on Choose the data for the back-
ground detection.

using Channel Select on which channel the detection
will be performed.

Save Captured Image

If Save Image to Database in the Capture task
is set to Never or Later, this task can be placed into
the job to decide when you want to save the images
(e.g. if a condition is met or when analysis brings sat-
isfying data).

Name Name of the task.

Save Image From Select the Capture task from
which the acquired images will be taken.

Capture N-SIM

Captures N-SIM image using the selected method. The
captured image is composed of several image tiles. A

single N-SIM image can be created within JOBS Ex-
plorer:

1. Open JOBS Explorer
2. Expand the JOB in the list to display job runs.
3. Select and right-click the job run used to capture

the N-SIM image.
4. SelectReconstruct N-SIM Image from the contextual

menu.

Caution

This task is only available with the Nikon N-SIM
module installed (it is a separate setup file).

NSim mode Select the mode for capturing the N-SIM
image.

Optical Configuration Select an optical configuration
which supports N-SIM acquisition.

Focus Offset Sets focus offset - see Capture Definition
for description.

STORM Acquisition

This task is used for acquisition using the STORM
(Stochastic Optical Reconstruction Microscopy) meth-
od.
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13.15.10 Stimulation

Sequential Stimulation

Chains acquisition time-phases and stimulation /
bleaching / waiting phases. For more information about
Sequential Stimulation please see Applications > 6D
> Define/Run Sequential Stimulation.

Simultaneous Stimulation

Runs a time-lapse acquisition and stimulation simul-
taneously. For more information about Simultaneous
Stimulation please seeApplications > 6D>Define/Run
Simultaneous Stimulation.

Define Stimulation ROI

(requires: Local Option)

This task defines ROIs on the live image using the
specified Optical Configuration.

Task Name Name of the Define Stimulation ROI task.

Create New Stimulation ROI Definition Creates a new
Stimulation ROI Definition.

Redefine Stimulation ROI Definition from Redefines
the existing Stimulation ROI Definition from the selec-
ted point/well loop.

Use OC Specify the Optical Configuration which will be
used for defining the ROIs.

St. Device Select the device for stimulation.

Draw ROI (s) This button runs the Live view and opens
the Simple ROI editor (see: ROI > Simple ROI Editor).

Define ROI(s) in Runtime If checked, this feature en-
ables to define ROIs during runtime.

Use Last Frame from Preview If checked, the last
frame from the preview is used for the ROI definition.

Clear ROI(s) before Definition Any previously drawn
stimulation ROIs (drawn by clicking Draw ROI(s) or
during Runtime) are cleared if this option is checked.

Define Laser Powers If checked, Laser Power Setting
dialog window appears when drawing stimulation ROIs.
This window enables to define power of each laser line
on each stimulation group.

Use Stimulation ROI from Analysis

(requires: Local Option)

This task takes binaries created in analyses and ap-
plies them to as Stimulation ROIs during stimulation
experiments.

Task Name Name of this task.

Load fromAnalysis Select the analysis task from which
the binaries will be taken and used as stimulation ROIs.

S1, S2, S3 These three combo boxes specify three
Stimulation groups and the binaries they are using.

Assign Stimulation ROI to Point/Well

(requires: Local Option)

This task assigns the stimulation ROI defined in the
Define Stimulation ROI to a Point of a point loop
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or Single Well/Row of Wells/Column of Wells of a well
loop.

Assign Stimulation ROI definition Select the desired
Define Stimulation ROI definition.

to Choose to which element you want to assign the
stimulation ROI.

13.15.11 Optical Configurations

Select Optical Configuration

Switches the system to the selected optical configura-
tion. You can make arbitrary changes on automated
devices such as changing the camera settings,
switching objectives, etc...

Optical Configuration Choose one of your optical
configurations to be activated.

Auto Brightness

This task can be used to automatically adjust bright-
ness settings (exposure time, gain, ...) based on the
parameters of the captured image.

DoAutoBrightness onSelect theOptical Configuration
on which auto brightness will be performed.

Target Maximum Intensity Determines intensity of
the lightest pixel in the resulting image. It is computed
as a percentage of the camera bit-depth. For 8-bit
cameras, the Target Maximum Intensity of 75% would
be 255 x 0.75 ~ 191.

Overillumination Tolerance Specifies number of pixels
which will be ignored when computing the Target
Maximum Intensity. For example, if your camera has
one or more defective pixels which gives constantly
the maximum value (white), these pixels shall be ex-
cluded from the calculation. Define the tolerance either
as percentage of all pixels (Relative) or Absolute by
specifying their number.

Estimate from single Capture Estimates the values
needed for Target Maximum Intensity from a single
capture.

Set Exposure to Optical Configuration

This task assigns desired camera exposure to an op-
tical configuration selected from the combo box.
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Name Name of this task.

Opt. Conf. Select an optical configuration to which the
exposure time value will be applied.

Absolute Absolute exposure value.

Multiply by Relative multiplier of the existing value in
an optical configuration.

Variable Specify the exposure value by selecting a
global value.

Adjust Camera Settings Manually in OC

This task is useful for changing camera settings during
a job run.

Name Name of this task.

Optical Configuration Select optical configuration
which will be used during the job run.

Live Window Position Choose where the Live window
will be placed. Three options are available: Main
Screen (main monitor), Second Screen (second monit-
or) and Progress Window (embeds into the Progress
window).

Live Window Size Select the size of the Live window.
General Options is the default size set inNIS-Elements
options. Tiled View rearranges your opened windows
together with the Live window to form a tiled layout.
Maximized fully maximizes the Live window.

Open Live Window automatically Check this option if
you want to launch the Live window automatically. If

you want to turn this window on manually, leave this
check box empty and click the Live button inside
the Job Execution Progress window after running the
job.

Figure 12.467. Bottom part of the Job Execution
Progress window

When you execute the Job, more options appear at the
bottom of the Job Execution Progress window:

Live window Turns on the Live window as defined
in the Adjust Camera Settings Manually in OC
task inside Job Definition.

Freeze Live window Freezes the Live window.

Camera settings This control opens the Camera
Settings dialog window.

Auto Brightness Enables applying automatic
brightness (exposure, gain, ...) on the selected optical
configuration.

Assign & Continue Clicking this button assigns the
current camera settings to the selected optical config-
uration and continues in the job progress.

Assign Camera Settings to Point/Well

This task takes camera settings from a selected optical
configuration and applies it to a selected row, column,
well or point.
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Name Name of this task.

Assign Camera Settings from Select optical configur-
ation from which the camera setting is taken for the
assignment.

to Select to which you want to assign the camera set-
tings and specify the selection in the last combo box.

Interpolate Exposures between Wells

This task interpolates/copies exposure values from
wells with known values (e.g. assigned by Set Expos-
ure to Optical Configuration ) to wells with un-
known values.

Name Name of this task.

Well Selection Select the desired Select Wells
task.

Optical Configuration Choose the desired Optical
Configuration used.

Method Choose one of the methods - Interpolate cal-
culates interpolation between two wells with known
exposure and applies the new values between these
two, whereas Copy copies known values to all ongoing
unknown values.

Direction Specifies the direction of Interpolating/Copy-
ing. Left to Right goes from left to right on each well

plate row, Top to Bottom goes from top to bottom on
each well plate column.

Use case example

When capturing fluorescence images on a well plate
using dilute solutions or suspensions, fluorescence
intensity may decrease linearly. Exposition and other
parameters can be adjusted only on the first and last
well of the dilution range - manually using Adjust
Camera Settings Manually in OC or automatically
using Auto Brightness . The middle section can
then be interpolated using the Interpolate Exposures
between Wells task.

Figure 12.470. Simple use case

Close Shutter

Closes the shutter specified within the task. Select one
of the shutters available in the system.
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Open Shutter

Opens the shutter specified within the task. Select one
of the shutters available in the system.

13.15.12 Conditions

Condition IF

If the specified conditional expression is evaluated to
TRUE, the contained tasks will be run. Otherwise the
contained tasks are skipped.

Figure 12.471. Example of an expression.

After defining your If condition it is possible to add
more conditions defined by different parameters. This
can be done by right-clicking the task's frame and
choosing Add 'Else' or Add 'If Else'. Else represents all
options except those defined by the condition. If Else
requires defining another condition in order to run its
contained tasks.

See also 13.13.2 Using Conditions.

Condition (If-Else)

If the specified expression is evaluated to TRUE, the
contained tasks will run. Otherwise the script proceeds
to “Else”.

If The same as in the Condition IF task.

Else Tasks contained in the Else section will be run
only if the specified conditional expression is evaluated
to FALSE.

See also 13.13.3 Using Expressions.

Every Nth

When using repetitive tasks (e.g.: repeats, well
loops,...), you can create a new task sequence that is
triggered by every first / last / nth loop using the Every
nth function. This task changes its options with respect
to the type of loop it is placed in.

Figure 12.473. Every Nth task inside a Loop over
Wells
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Figure 12.474. Every Nth task inside a Loop over
Plates

Figure 12.475. Every Nth task inside a Loop over
Points

Figure 12.476. Every Nth task inside a Z-Stack Loop

Figure 12.477. Every Nth task inside a Time Lapse

Loop Choose the loop you would like to modify by this
task.

Every Enter the desired number of the repeated task.

First Executes after the first repetitive task selected.

Last Executes after the last repetitive task selected.

Include First Specifies whether the inner tasks will be
executed also on the first Plate/Point/Time Loop or
not.

Every n-th Row/Column Select this option to execute
the inner tasks only on selected wells. These are
defined using the icons below, described in the task
caption and shown in the preview area as red circles.

Every n-th Well Select this option to execute the inner
tasks only on selected wells. These are defined using
the icons below, described in the task caption and
shown in the preview area as red circles.

Full Z-Stack Executes the inner tasks on each plane
of the Z-Stack defined by the Define Z-Stack task.

Top/Home/Bottom slices Specifies the part of the Z-
Stack and how many slides are taken into account
when performing the inner tasks.

Break

Exits execution of the selected loop and continues to
subsequent tasks.

Break from Select one of the parent loops to exit. The
job will continue with the task following the selected
loop.

13.15.13 System

Question

Displays a pop-up window requiring user interaction.
After “answering” by clicking one of the buttons, the
job continues.
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Name Name your question.

ShowPreview...Displays the preview window showing
how the defined question will look like.

Icon Choose an icon which will be displayed together
with your question. Four graphics are available: Inform-
ation, Question, Exclamation and Error.

Caption Type a text to be used in the dialog window
heading.

Wait for user action Stops the job sequence until the
user answers the question. If the Keep visible during
current loop execution option is selected, the question
stays visible during the loop execution even after user
input.

Continue execution and stay visible If checking this
option, the question shows up and the job continues
even without user interaction.

Input Values Check if you want to input any user data
(e.g. defined in Variables ). Click the Add New
button and select the variable. Name of the selected
variable can be set in the Text field. To change the
variable, click ... .

Buttons
Combination PresetsHere you can choose some
predefined button combinations.

Label Define the button names to be displayed
when the question is to be answered.

Escape Key, Enter Key Select which buttons will
correspond to Esc and Enter key-strokes.

Add New Adds a new button.

Remove the button Removes the selected button.

Remove All Removes all buttons.

For more information about using Questions please
see: 13.13.4 Using Questions.

Macro

This task enables the user to write and run a macro.
The whole set of available macro commands can be
used. Write sophisticated C-like scripts for tasks which
cannot be done by a Job or reuse your existing macro.
Please see 10. Macros also.

Using Job Parameters within the Macro Task

Figure 12.479. Macro job example 1

This example job generates a point set (pattern of
points on a wellplate) without moving the stage. The
embedded macro fills the point set with x and y coordin-
ates of the center of each well from the well selection.
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Obtained points can be used later in a different job for
a fast acquisition.
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Figure 12.480. Macro job example 2
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This example job has similar functionality as the Keep
Object In View task following the object of interest
and keeping it in the center of the camera FOV. In this
specific job, three manually selected objects are fol-
lowed for an amount of time set in the Time Lapse

. The first macro defines the variables and declares
objective calibration. Then the three points are manu-
ally marked using the Predefined Points task.
Loop over Points is performed once and
thresholding defined in the General Analysis is
used for identifying the objects of interest. The second
macro sets the objects initial position into the pre-
defined variables. The third macro finds the current x
and y position of the center of the object and shifts
the stage to these coordinates. Then it updates the
objects position in the point set with the current posi-
tion.

Another example of using a macro job can be found
here: Jobs_SetFilenamePart
[_includes/call_fr.html#FR_Jobs_SetFilenamePart.html].

Expression

Assigns values to variables available within the job. It
enables to modify settings of any tasks, manipulate
motorized devices, etc. For more information about
working with expressions please see 13.13.3 Using
Expressions.

Variables

Declares global variables within NIS-Elements.

Note

In programming, global variable is a variable ac-
cessible from anywhere in the application (NIS-
Elements in this case). Unlike local variable which
is accessible in a limited scope (such as a macro

function). Global variables declared by this task
can be accessed e.g. by a macro.

Add new Add a new variable to the Variables list.

Remove the variable Removes the selected vari-
able.

Remove All Clears the list of Variables.

Variable name Name your variable.

Type Choose the numeric type of your variable. You
can choose between: Integer (integral number), Double
(real number), String (sequence of characters).

Current value A value can be assigned to the variable
within this task or within Expression .

Always Initiate Each variable keeps its value after the
job is finished. Initialization resets the variable value
to Initial Value at the beginning of the job.

Initial value Set your initial variable value.

Custom Metadata

Enables to enter custom metadata to be used before
(in wizard) or during the job run. Metadata can be
created and managed in the Manage Custom
Metadata dialog window (see Defining and Setting
Metadata). Defined metadata of different types (e.g.
numeric value, text, selection, date,...) are grouped
into metadata sets and stored in the database.
Metadata information applied by this task during the
job are recorded into job results and into corresponding
captured images.
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Jobrun Name Custom name of the jobrun.

Jobrun Description Custom description of the jobrun.

Custom Metadata If checked, custom metadata will
be used. Select a metadata set and choose which
metadata from this set will be used from the neighbor-
ing combo box. Active metadata values can be adjusted
in the edit boxes below depending on the use of this
task in your job definition.

Presets Presets defined in the Presets tab of Manage
CustomMetadata (see:Defining and SettingMetadata)
are displayed here as buttons for quick switching
between them.

Wait

This task pauses the job for a specified amount of
time.

Wait name Name of your Wait task.

Duration Amount of time for which the job will be
paused.

Comment

This task can be used for adding constantly visible
notes / comments right into the job sequence. This
way you can write down information to easily explain
the particular job procedure to a different user seeing
the job for the first time.

Send E-mail Notification

Sends an email to the specified address. SMTP server
configuration (within the task) must be correct. You
can send results of the experiment, messages about
the experiment progress (failed, finished, in pro-
gress,...), etc.

To Enter the recipient's e-mail address.

E-mail Setup... This function opens the SMTP Config-
uration window (please see HCA/JOBS > Presets >
Email Setup).

Subject Type the subject of your e-mail.

Send Now This function allows you to send your e-mail
immediately.

Text Box Here you can type your message combined
with your job variables.

... The ... button on the right side adjacent to the text
box enables inserting job variables. You can also use
your custom variables defined in the Variables task
(see Variables ).

93

JOBS and HCA



Examples: Notification about the Job experiment end,
notification to exchange well plates, notification that
auto focus failed, etc.

Send SMS Notification

Sends a text message to the specified phone number
if the particular mobile phone operator provides such
services (sending SMS over email).

Phone Number Type the recipient's phone number.

Carrier Select the local mobile operator of the entered
Phone number.

Send Now This function allows you to send your SMS
immediately.

E-mail Setup This function opens the SMTP Configur-
ation window (see HCA/JOBS > Presets > Email Setup
).

Text Box Here you can type your message combined
with your job variables.

... The ... button on the right side adjacent to the text
box enables inserting job variables. You can also use
your custom variables defined in the Variables task
(see Variables ).

Create Labels

This task defines labels which can be used for labeling
single wells or single points during runtime.

Add labels by clicking the Select Labels... button or
by clicking the Add New. Set their name and
choose the labeling color. You must use the Assign
Label task to assign these settings.

Assign Label

This task assigns labels set in Create Labels to
wells or points during runtime. Filtering by these labels
inside Well Loops and Point Loops is possible. Select
a label from the Set Label list and assign it to a
well/point loop. Check Reset other Labels if you want
to clear existing labels.

Tip

Use this task with a Question task inside a
well / point loop. During the first loop you can use
the question buttons to manually decide which
wells / points are suitable / unsuitable e.g. for a
precise capture. The high magnification capture
can then be made during the second loop only
over wells / points specifically marked in the first
loop.
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Figure 12.488. Label use case

Debug

This task enables to select specific parameters and
list them inside the Job Execution Progress window.
Values are displayed and the Job is paused until
Continue is pushed.

Phase

Some use cases can be logically separated into Phases
(preparation, verification, acquisition). This task can
be used for holding parts of the job, creating conditions
between these parts and running these parts in a
custom order.

Example 12.8. Example of a well plate acquisition job
separated into 4 phases:

1. Find interesting locations within wells
2. Run Autofocus at each location
3. Verify locations and proper Focus
4. Run Acquisition

Figure 12.490. Phase task
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All task contained in the dashed area at the bottom of
the task can be executed Anytime or Only after other
Phases. Such condition can be created in the Expres-
sion area using basic Operators and Insert for insert-
ing the selected phase. After defining phases and
clicking Run Job , options for their direct execution
or execution of the whole job are shown below.

Figure 12.491. Job Execution sub-menu

After a phase is executed, this information is stored
so that the job can later be executed from the following
phase. Each phase can be executed multiple times
and the job can still be executed whole at once.

Finish

This task enables to finish the current job run.

Abort

This task enables to cancel the current job run.

Execute Macro After Run

(requires: Local Option)

Enables to enter a macro-command which can be
performed on Finish and/or on Abort of the job. See
also 10. Macros.

Macro on Finish Executes the specified macro on Job
Finish.

Macro on Abort Executes the specified macro on Job
Abort.

Drop-down menu Click the arrow button to reveal a
menu enabling to Insert Content of Macro... from a
.mac file, Execute Macro... from a .mac file or to Ap-
pend Command... from the Command list.

Alternative Storage Location

NIS-Elements database is ignored and all acquired
files are saved into the specified folder.

Store Files to Defines where the acquired files will be
saved.

Put files from all runs into specified folder (add a
distinguishing unique prefix) All runs are placed into
a single folder. Unique prefix is added.
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Put files of each run into separate unique subfolder
Files from each job run are placed into a separate
folder.

Open First Acquired File After Run First file acquired
in the particular job is opened in NIS-Elements after
the job run.

13.15.14 Analysis

This task section contains other jobs analyses. To be
able to execute any analysis in Jobs, your job definition
has to contain Capture Definition and Capture

.

Define Analysis

This task can be used to define multiple analyses
which can be run during or after image acquisition.

Link the task to your Capture task displayed in
the Analyze combo box. Now choose your first analysis
from the combo box in the table <Select Analysis>.
Name it and choose when it will be executed. Click
Define... and set up the current analysis. Please see
10.3 HCA Analysis for details about each analysis.

JOBS Recipe Manager (requires: Local Option)

Clicking on ... in the Analysis task caption opens the
JOBS Recipe Manager where it is possible to Im-
port/ Load from NIS... any previously created ana-
lysis recipes. Recipes marked with a check mark are
arranged in a new section called Analysis Recipes in
the Job Definition Task Palette.

General Analysis

General analysis in jobs has the same functionality as
General analysis from the Image menu, however in
Jobs it brings much more versatility. Parameters of the
General Analysis task are closely described here:
2.5 General Analysis.

Once you set up a General analysis it can be later used
as a custom task. To do so, first you have to save your
analysis settings (for General analysis from the Image
menu click Save as... and name your .ga file, for
General analysis in Jobs click Save Recipe ). Then click
... and search for your saved settings. Use the
Import... or Load from NIS... buttons if your analysis is
not already listed. Then select the desired recipe and
click OK . Selected analysis recipe carrying the analysis
settings is now represented by a custom task inside
the Analysis Recipes section of the task palette.

Cell Count Analysis

Parameters of this analysis are closely described here:
2.2 Cell Count Analysis.

Intensity Analysis

(requires: Local Option)

Parameters of this analysis are closely described here:
2.6 Image Intensity Analysis.
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General Analysis RGB

(requires: Local Option)

(requires: General Analysis)

Parameters of this analysis are closely described here:
Image > General Analysis RGB.

Out Proc

(requires: Local Option)

This task enables to use an external program to pro-
cess/analyze images captured via JOBS. If the external
program produces output in a form of binary images
or an array of values in a text file, JOBS load and use
them for further analysis.

Analysis Name, Run: The top part of the window is
common to all analysis windows are described in the
13.9 Analysis chapter.

Input Image Name and path to the TIF image gener-
ated by NIS-Elements for analysis. E.g. “C:\color.tif”

Sync Status Name and path to the text file with status
of the analysis. E.g. “C:\sync.txt”. This file is shared
between NIS-Elements and the external program.
Running processes can communicate due to the sync
status saved in this file. Possible values are:

0 Not ready

1 Ready for analysis

2 Analysis is finished

3 Cancel execution

Out Params Name and path to the text file where
analysis results will be saved. E.g. “C:\output-
params.txt”. It will contain a list of values specified in
the Output Parameters section.

Out Points Points are generated into this file by the
external application (e.g. points representing centers
of binaries).

Run Process for Analysis Select this option if the ex-
ternal program you use runs on demand and needs to
be called to process each image. Programs which run
independently and are capable of checking the content
of the Sync Status file do not need this function.

Process Name Name and path of the external
program.

Process Parameters Any parameters needed for
the external program.

Kill Process, Timeout [ms] Programs which do
not end automatically can be killed after the
defined Timeout.

Output BinariesDefinition of binary TIF files generated
by the external program which ought to be loaded by
NIS-Elements after analysis. The first field specifies
name of the binary layer, the second field is a name
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and path to the TIF file containing the binary image
data.

Output Parameters Definition of result values gener-
ated by the external program. Supposedly, the external
program generates a list of values, each value on a
new line. This definition pairs these values to its de-
scription under which they will be available within NIS-
Elements.

Output point coordinates Defines where the points
are saved (point list defined by a task).

Preview Runs the analysis on the current image.

Processing with ImageJ

Figure 12.496. Out Proc processing with ImageJ

Out Proc task also enables to process images using
ImageJ. Set the path of the Input Images generated
by NIS-Elements and the path to the file containing
results generated by ImageJ (Out Params). It is import-

ant to let the Sync Status field empty. Enable Run
Process For Analysis and set the Process Name as an
executable ImageJ file. Specify the macro and other
options in the Process Parameters field. For example
to measure the image area and mean gray value using
ImageJ enter the following macro:

path = getDirectory("im-
agej")+"NIS"+File.separator;

print (path);

open(path+"input.tif");

run("Input/Output...", "jpeg=85 gif=-
1 file=.txt use_file");

run("Set Measurements...", "area mean
redirect=None decimal=3");

run("Measure");

saveAs("Results", path+"Results.txt");

eval("script", "System.exit(0);");

Measured results are connected to the output para-
meters specified in the Output Parameters area of the
Out Proc task and are shown in the Job Results dialog
window.

Wound Healing

(requires: Local Option)

This task controls the wound healing analysis used for
measuring changes of cell distribution in time.
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The top buttons which are common to all analysis
windows are described in the 13.9 Analysis chapter.

Analysis Name Name your wound healing analysis.

Run Specify in which phase will the analysis be ex-
ecuted (During Acquisition or After Acquisition).

Close Holes - Count This command fills holes in detec-
ted objects. Specify how many times the command will
be run.

Delete Small Objects - Count This command deletes
the smallest objects. Set how many times the com-
mand will be run. Use the Preview button to check your
current image settings.

Do Postprocessing Check if you want to use postpro-
cessing.

Preview Check if you want to see a live preview of your
current wound healing settings.

13.15.15 Ga3 Processing

Please see 9.4 GA3 in Jobs.

13.15.16 Device Control

(requires: Local Option)

Temperature and Gas Control

(requires: Local Option)

Sets the target temperature and gas concentration.

Name Name your Temperature and Gas Control task.

Run asynchronously When selected, the subsequent
tasks will be run immediately - the system will not wait
till the time-out is reached or the temperature/concen-
tration achieved.

Continue after timeout This option overrides the
Timeout settings which are ignored. The task waits
until the defined temperature/concentration is
reached.

Set heating Check this box if you want to adjust the
temperature.

Target Temperature Set the target temperature
of your selected device.

Tolerance above, Tolerance below Select the
tolerance interval above and below your Target
Temperature. If any temperature within this inter-
val is reached, the system considers the task to
be finished successfully.

Temperature increase/decrease If this option is
available, you can set the speed of heating. Three
options are available: Fastest, Time to reach the
Temperature and Rate of change (choose a
change rate in degrees per minute). Only some
devices support this feature.
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Time out Time out specifies the time given to
reach the target temperature. If the device does
not reach it in time, the job will continue neverthe-
less. If the temperature is reached before the
time-out, the job will continue immediately.

Turn off heating Once the task is used to reach a
temperature, the device holds the temperature within
the given tolerance. Select this option if you want to
turn the heating off in another part of the job.

... CO2, ... O2
Set Concentration Set the target concentration
of the selected gas.

Time out Time given to the task to reach the
concentration (see above).

Analog Out

This task controls analog output devices.

Device Type Type of the output device.

Name Analog output name.

Output Output voltage set by clicking ... .

Index of Job Tasks

Symbols

A
Abort, 96
Add Point to Point Set, 67
Add/Edit Points Manually, 67
Adjust Camera Settings Manually in OC, 85
Align Plate, 55
Align Slide, 60
Alternative Storage Location, 96
Analog Out, 101
Append Point Set to Point Set, 67
Append Region List to Region List, 72
Assign Camera Settings to Point/Well, 85
Assign current Z to Point/Well, 77
Assign Label, 94
Assign PFS to Point/Well, 78
Assign Stimulation ROI to Point/Well, 83
Assign Z-Stack to Point/Well/ND Acquisition, 74
Auto Brightness, 84
Auto PFS Offset Settings, 77
Autofocus, 76
Autofocus Settings, 74

B
Break, 88

C
Capture, 79
Capture Definition, 78
Capture N-SIM, 82
Cell Count Analysis, 97
Clear Point Set, 67
Clear Region List, 72
Close Shutter, 86
Comment, 93
Condition (If-Else), 87
Condition IF, 87
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Create Focus Surface, 76
Create Labels, 94
Create PFS Surface, 78
Custom Metadata, 92

D
Debug, 95
Define Analysis, 97
Define Plate, 51
Define Slide, 59
Define Stage Area, 60
Define Stimulation ROI, 83
Define Z-Stack, 72
Defining and Setting Labels, 33
Defining and Setting Metadata, 33
Detect Background, 81
Draw Regions, 70

E
Edit Regions, 71
Escape Z, 77
Every Nth, 87
Execute Macro After Run, 96
Export Point Set to ND, 68
Expression, 92

F
Fast Timelapse, 80
Find Auto PFS Offset, 78
Finish, 96

G
General Analysis, 97
General Analysis 3,
General Analysis RGB, 98
Generate Points, 64

H
Holder, 59

I
Illumination Sequence, 81

Import Point Set from ND, 68
Intensity Analysis, 97
Interpolate Exposures between Wells, 86

K
Keep Object In View, 64

L
Label Wells, 54
Labeling/Quantities window, 31
Live Window, 81
Loop over Holder, 62
Loop over Plates, 58
Loop over Points, 65
Loop over Regions, 72
Loop over Slides, 62
Loop Over Wells, 54

M
Macro, 89
Manual Plate List, 57
Manual Slide List, 61
Merge and Store Captured Images, 81
Move to Focus Surface, 76
Move to PFS Surface, 78
Move to Point, 66
Move to Previous/Next Point, 66
Move to Previous/Next Well, 59
Move to Region Center, 72
Move to Well, 58
Move to Well Center, 58
Move to Z-Stack home, 74

N
ND Acquisition, 80
New Point Set, 65

O
Offset Focus Surface, 76
Offset PFS Surface, 78
Offset Point Set, 66
Open Shutter, 87
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Out Proc, 98

P
PFS Off, 77
PFS Offset from the current Z position, 77
PFS On and Focus, 77
Phase, 95
Plate Loader, 56
Predefined Points, 65

Q
Question, 88

R
Refocus Z, 77
Region List, 71
Remove Point from Point Set, 67
Repeat N times, 63

S
Save Captured Image, 82
Scan Large Image, 68
Scan Large Image in Region, 69
Scan Large Image in Slide/Well/Area, 69
Select Optical Configuration, 84
Select Wells, 53
Send E-mail Notification, 93
Send SMS Notification, 94
Sequential Stimulation, 83
Set Exposure to Optical Configuration, 84
Shift Region, 70
Simultaneous Stimulation, 83
Slide Loader, 61
STORM Acquisition, 82

T
Temperature and Gas Control, 100
Time Lapse, 62, 63
Time Sequence, 63
Triggered Experiment, 80

U
Use Stimulation ROI from Analysis, 83

V
Variables, 92

W
Wait, 93
Wound Healing, 99

Z
Z-Stack Loop, 74
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